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I BOB. RASTR TASVIRLARNI QAYTA ISHLASH

1.1. Kompyuter grafikasi hagida tushuncha

Shaxsiy kompyuter va uning dasturiy ta’minoti rivojlanishi ham-
da takomillashuvi kompyuter yordamida avvallari bajarib bo‘lin-
magan vazifa va ishlarni amalga oshirish imkoniga olib keldi.
Buning natijasida, kompyuter yordamida tasvirlarni yaratish va
ularga ishlov berish, ya’ni kompyuter grafikasi tushunchasi vujudga
keldi. Shuni aytib o‘tish kerakki, bungacha ham kompyuter gra-
fikasi mavjud bo‘lgan, lekin u, asosan, dasturlash tillari yordamida
yaratiladigan geometrik shakllar va tasvirlar ko‘rinishida bo‘lgan.

Tasvirni (dastlab matn, formula, so‘ng oddiy rasm) kompyuter
ekraniga chigarish kompyuter grafikasining rivojlanishida birinchi
gadam bo‘ldi. Qisqa vaqt ichida (o‘tgan asrning 50-yillaridan
boshlab) kompyuter grafikasi tez sur’atlarda rivojlandi va o‘ziga
¢’tiborni tortdi.

Kompyuter grafikasi mustaqil yo‘nalish sifatida XX asrning
60-yillarida paydo bo‘ldi va buning uchun maxsus amaliy dasturlar
paketi ishlab chiqildi. Ular kesmalar yordamida chizish, chiziqg-
larni o‘chirish, murakkab sirtlarni akslantirish usullari, soyalarni
shakllantirish, yoritilganlikni hisobga olish kabi tamoyillarni o‘z
ichiga olgan edi. Bu yo‘nalishdagi ishlar vektorli grafika, ya'ni tas-
virlarni kesmalar orqgali chizishni rivojlantirishga yo‘naltirilgan edi.

70-yillardan boshlab nazariy va amaliy ishlarning aksariyati
fazoviy shakl va obyektlarni o‘rganishga garatildi. Bu yo‘nalish
uch o‘lchovli (3D) grafika nomi bilan atala boshlandi. Uch o‘Ichovli
tasvirlarni modellashtirish fazoning va jismlarning uch o‘lchovligini,
kuzatuvchi va yoritish manbalarining joylashishini hisobga olinishini
talab gilar edi. Murakkab sirtlarni akslantirish, relyeflar va ularning
yoritilganligini modellashtirish bilan bog‘liq masalalarning paydo
bo‘lishi uch o‘lchovli grafikaga bo‘lgan ehtiyojni yanada oshirdi.

90-yillarda kompyuter grafikasining qo‘llanish sohalari yanada
kengaydi, uni keng tatbiq qilish imkoniyatlari paydo bo‘ldi. Natijada
kompyuter grafikasining yangi yo‘nalishlaridan biri — hagqiqiy tas-
virlarni shakllantirish vujudga keldi va shunday tasvirlarga ehtiyoj
dizayn, arxitektura, reklama va boshga sohalarda paydo bo‘ldi.
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Kompyuterlar funksional imkoniyatlarining kengayishi kom-
pyuter grafikasining rivojlanishiga asos yaratdi va tasvirlar ani-
matsiyasining yaratilishiga olib keldi. Bu yo‘nalishni uchta guruhga
ajratish mumkin:

— tibbiyot, kimyo va boshqga sohalardagi jarayonlarni ko‘rgaz-
mali namoyish etish;

— kompyuter o‘yinlari (imitatsiya);

— kino va televideniya uchun tasvirlar.

Hozirgi davr yangi texnika va texnologiyalarni kompyuter texno-
logivalari asosida ishlab chiqgarish va tashkil qilish asri hisoblanadi.
Shuning uchun barcha sohalardagi kabi, tasvirlarni yaratish, gayta
ishlash va muhandislik loyihalashda ham kompyuterlardan foy-
dalanish hozirgi kunda dolzarb bo‘lib golmogqda.

Tasvir ko‘rinishida berilgan axborotlarni kompyuterda gayta
ishlash texnologiyalari xilma-xil bo‘lib, juda ko‘p amaliy masalalarni
hal qilishga tatbiq etiladi.

Tasvirlarni gayta ishlash masalalarining amaliy tatbiglariga misol
tarigasida uzatish tizimi xizmat qilishi mumkin. Bu tizimda ma’lu-
motlarni kichik hajmli qilib kodlashtirish, tasvirdagi ortiqcha xalaqit
beruvchi unsurlarni kamaytirish masalalari hal gilinishi kerak.
Tasvirlar sifatini ma’lum bir mezon bo‘yicha yaxshilash (masalan,
tasvirni tiklash, ranglarni o‘zgartirish, kontrastini oshirish), ularni
tubdan o‘zgartirib yuboruvchi maxsus almashtirishlar ham tasvir-
larni qayta ishlash masalalari bo‘lishi mumkin.

Tasvirni gayta ishlashda, masalan, tasvirdagi ayrim elementlarni
olib tashlash (ovoz, rang, ...) yoki qo‘shish, uning hajmini o‘z-
gartirish va hokazolarda kiruvchi va chiquvchi ma’lumotlar — tas-
virlar bo‘ladi.

Tasvir ko‘rinishga ega bo‘lmagan axborotlarni vizuallashtirish
(ya’ni tasvirni yaratish) masalalari bilan kompyuter grafikasi
(computer graphics) shug‘ullanadi.

Kompyuter (mashina) grafikasi dastlabki, ya’ni kiruvchi
axborotni (noma’lum tabiatga ega) tasvir ko‘rinishiga olib keladi.
Masalan, ma’lumotlarni grafik, diagramma yoki boshga shakllarda
vizuallashtirish. Bundan tashqari, shakllarni almashtirish, harakat-
lantirish, virtual tasavvurga yagqinlashtirish.

Shuni ta’kidlab o‘tish joizki, grafiklar vaqtga nisbatan o‘zgarmas
bo‘ladi. Ayrim kompyuter o‘yinlari vaqt oralig‘ida o‘zgarib turadi.
Boshgalarida esa real dunyo obyektlari bilan bo‘layotgan o‘zgarish-
larni tasvirlovchi illuziya hosil bo‘ladi.
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Vizual obyektlarni tanib olish gandaydir ma’noda kompyuter
grafikasi masalasiga teskari masaladir. Chunki berilgan tavsiflar
asosida tasvirni yaratish kompyuter grafikasining masalasi bo‘lsa,
uning tavsiflarini hosil gilish tavsiflarni tanib olish masalasi hisoblanadi.

1.2. Kompyuter grafikasi turlari

Kompyuter grafikasi va dizayni, asosan, elektron rasm, tas-
virlar va boshga texnik vositalar orgali import gilingan rasmlar
bilan ishlashni o‘rgatadi. Hozirgi kunda grafik dasturlarning soni
juda ko‘p bo‘lib, ular ishlash prinsipiga ko‘ra farqlanadi. Ushbu
o‘quv qo‘llanmada kompyuter grafikasining rastrli (nugqtali),
vektorli (obyektli) va fraktal turlari hagida boshlang‘ich
tushunchalar keltirilgan.

Rastrli grafika bilan ishlovchi dasturlar Paint, Adobe Photoshop,
CorelPhotoPaint — bu dasturlarda har bir tasvir nuqtalar — piksellar
to‘plami asosida ko‘riladi. Bu dasturlar yordamida yaratilgan fayllar
*.bmp, *.jpg, *.psd, *.tif formatlarida saglanishi mumkin. Bu
turdagi fayllarda saqlangan tasvirlar ranglarining yorqginligi bilan
ajralib turadi. Ularning kamchiligi sifatida tasvirni kattalashtirish
bilan uning sifati yo‘qolib borishi va xotirada ko‘p joy egallashini
aytib o‘tish lozim. Shuning uchun, ko‘pincha, bu formatlardan
tayyor rasmlarni gayta ishlashda foydalanish tavsiya gilinadi.

Vektorli grafika bilan ishlovchi dasturlar CorelDRAW, Auto-
CAD, Adobe Illustrator, Macromedia Flash, 3DS MAX va
boshgalar — bu dasturlarda har bir tasvir ma’lum shakl va chiziglar
asosida quriladi.

Bu dasturlarda ikki yoki uch o‘lchovli tasvirlar bilan ishlashning
mumkinligi, obyektlarni kattalashtirish bilan ularning sifatining
o‘zgarmasligi va katta instrument (asbob)lar bazasining mavjudligi
foydalanuvchilar uchun katta imkoniyatlar yaratadi. Yaratilgan
fayllar *.cdr, *.dwg kabi formatlarda saglanadi.

Ushbu dasturlarda yaratilgan tasvirlar turli chiziglar va qiyshiq
vektorlardan iborat bo‘ladi. Vektorli grafikada yaratilgan rasmlardan
logotip, illustratsiya va lavha (zastavka)lar yaratishda foydalaniladi.

Fraktal grafika — tasvirlarni matematik hisoblashlar asosida
avtomatik yaratish uchun qo‘llaniladi. Shuning uchun ham uning
asosi sifatida shakl, tasvir hosil gilishning dasturlash usuli olingan.

Bu grafika, odatda, turli jarayonlarni modellashtirish, tahlil
qgilish, turli gizigtiruvchi dasturlar yaratishda keng qo‘llaniladi.
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Ushbu go‘llanmada o‘quvchilar rastr grafikasi bilan ishlashdan
mukammal bilim olishlari uchun, asosan, rastrli (piksel) grafikaga
ko‘proq e’tibor beriladi. Shu bilan birga, vektor grafikasidan ham
gisqgacha ma’lumotlar beriladi, chunki bu grafika turida fagatgina
tasvirlar bilan ishlashgina emas, balki shu tasvirlarni yaratish im-
koniyati ham mavjuddir.

1.3. Kompyuter grafikasi turlarining farglanishi

Rastrli grafikaning vektorli grafikadan farqi shundaki, rastrli
grafikada tasvir kattalashtirilgani sayin uning sifati yo‘qolib boradi
va xotiradan ko‘p joy egallaydi.

Fraktal grafikada hisoblashlarni amalga oshirish kerak bo‘lib,
uning vektor grafikadan farqi shundaki, unda hech ganday obyekt-
lar kompyuter xotirasida saglanmaydi, chunki tasvirlar tenglamalar
yoki ularning tizimlari orgali hosil gilinadi. Shuning uchun ham
xotirada tenglamalargina saglanadi.

1.4. Photoshop dasturida tasvirlarni ochish

Adobe Photoshop dasturida tasvir (fayl)ni ochish uchun quyi-
dagilarni bajarish kerak:

1. Menyuning File > Open (Fayl > Otkpwits) (File > Browse
(®aiin > IIpocmotp)) buyrug‘ini tanlang yoki Ctrl+O
(Shift+Ctrl+0) tugmalari majmuasidan foydalaning.

2. Ochilishi kerak bo‘lgan faylni tanlang (1-rasm).

Open i E3
Derva: [Sito e = 8| @ o [= mi =)
6001 6 Tl 6007 1 Tl 60130 Tl et
Il 6002 6 |l sooew I eoram 8 6020 1
8l 6003 & ) sooai 8 6015 B8l 6021 i
[l 6004 o fal smow [ BB B2z
8l 6005 ] R 601 7.4t 8l 6023
8] 5008 & W emzu 8 emaw 8] 60241
‘ >
Hrm padina lﬁ'm I Drepems I
Tiun gafinon: [N Formats =l Orpemria I

File Size: 471K
&

1-rasm. Open buyrug‘i yordamida fayllarni ochish.
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Agarda tasvir kichiklashtirilgan nusxada saglangan bo‘lsa,
tasvirni ko‘rish uchun Show Preview (IIpeasaputeibHbId MpoC-
Motp)ga sichqgoncha bilan bosing. Agarda faylni File > Browse
yordamida ochgan bo‘lsangiz, hamma tasvirlar kichiklashtirilgan
formatda berilgan bo‘ladi, istalganini sichqoncha yordamida tanlab,
ko‘rsa bo‘ladi (2-rasm).

"I} File Browser |- O] x|
=i-[#] Daii+ié ol El
: | r |
5 glié Eiliipadl | & |lores =z @

o |

Filename 6001.TF ﬂ E002.4if
Date Created 230602 04:46:34

Date Modified 121055 10:23:24
Image Format TIFF (5

Width 430 -
Jiil 3 v
All ’ 4 File * La. * ™ Iz

2-rasm. Browse buyrug‘i yordamida fayllarni ochish.

Rank: -

Agarda katalogda tasvirlar soni ko‘p bo‘lsa, ularning miniatura-
sini yaratish birmuncha vaqt olishi mumkin.

Barcha formatdagi fayllarni ekranga chiqarish uchun Files of
type (Tumbl daiinos) ochilib chiqadigan menyusidan 4ll Formats
(Bce dopmatnl) variantini tanlash kerak.

Tasvir ochilgandan keyin, uni Photoshop dasturidagi mavjud
formatlarda saqlash mumkin bo‘ladi.

Agarda fayl nomi fayllar ro‘yxatidan chigmasa, bu faylning
formati uchun Photoshop dasturida uni ochuvchi maxsus modul
mavjud emas deganini anglatadi. U holda bu modulni o‘matish

kerak bo‘ladi.



3. Fayl nomini ajratib, Open (OTKpbITh) tugmasini yoki fayl
nomining ustiga ikki marta ketma-ket sichqonchaning tugmasi
bosiladi.

Profillar mos kelmagan holda IT bobda berilgan yo‘rignomadan
foydalanilsa bo‘ladi.

Ba’zi formatlar uchun yana bir muloqot oynasi ochilishi mum-
kin. Masalan, EPS, Adobe Illustrator yoki PDF formatida saq-
langan fayllarni ochganda, tasvir vektor ko‘rinishidan rastr ko‘ri-
nishiga o‘tkazilmagan bo‘lsa, u holda Rasterize Generic Format
(Pactepu3amms dopmara) oynasi ochiladi. (Bu hagda <EPS, PDF
formatli yoki Illustrator dasturi fayllarini ochish» bo‘limida kengroq
ma’lumot berilgan.)

Ba’zi formatlarni ochish uchun maxsus modullar kerak bo‘ladi.
Masalan, Scitex Ctrl yoki PICT Resource formatli fayllar. Bu
fayllarni ochish uchun File > Import (®aiin > ViMmopt) buyru-
g‘ini bajarish talab etiladi.

Faylni ochishda aniq formatni ko‘rsatish uchun menyuning
File > Open As (@aiin > OTKpuITh KaK) buyrug‘ini bajaring va
ochilgan oynadan kerakli formatni tanlab, keyin Open (OKTpbITD)
tugmasini bosing.

Joriy oynalar orasida bir-biriga tez o‘tish uchun «gaynog»
tugma — Ctrl+Tab dan foydalaning.

Yaqinda yopilgan faylni ochish uchun menyuning File > Open
Recent (®aiin > Hemaeno okTpeiThie) buyrug‘idan foydalaning.

1.5. Yangi yaratilgan tasvirlarni xotiraga saqlash

Yangi yaratilgan tasvirlarni xotiraga saglash uchun quyidagilarni
amalga oshirish kerak:

1. File > Save (®aiin > Coxpanats) buyrug‘ini tanlang yoki
Ctrl+S tugmalar majmuasidan foydalaning.

2. Ochilgan mulogot oynasida File name (Mmsa ¢aiina) may-
doniga fayl nomini Kkiriting.

3. Faylning diskdagi saqlanadigan joyini ko‘rsating. Agarda
faylni joriy papka yoki diskdan boshqa joyga saglamoqchi bo‘lsangiz,
mulogot oynasining yuqori gismida joylashgan menyudan foyda-
lanib, kerakli joyni ko‘rsating.

4. Save As (Coxpanutb Kak) ochilib chiquvchi menyusidan fayl
formatini tanlang (3-rasm).



Save As (2]

Donxa: |3 Lo_res = gl @n il Eﬂl
60011 3] 6007.1i B013.8t |5 EIE

&) 6002 &) o081 &) sm 4.t &) sozoui
&) 60034 [ so09. B sms &) soz1.4
[ 6004.4 BO10.6 [l s06. Bl sz
[ so0s.4 Bl so1u Bemzi Bl sz
&l s00s.4 BO124 EOTR Bl sozan

~Save Options PS ['.E
Save: Phatashop DCS 1.0“EPS)
Phatoshop DCS 2.0 (~EPS)
JPEG (~JPG;"JPEG." JPE]
|Photoshop POF [*.PDF.* PDP)
Raw [ Raw)
Color; Seitex CT [*SCT)
TIFF [~ TIF~TIFF

| | Thumbna ¥ Use Lower Case Extension

3-rasm. Save As mulogot oynasi.

Agarda tasvir ko‘p qatlamli bo‘lsa, ular Photoshop dasturining
formatlari, Advanced TIFF yoki Photoshop PDF formatlarida
saglanishi mumkin.

5. Save Options (Ilapametrpsl coxpanenmne) guruhi maydon-
lariga zarur bo‘lgan bayroqchalarni qo‘ying. Shuningdek, ranglar
uchun ham bayroqcha qo‘ysa bo‘ladi, agarda faylda profillar
mavjud bo‘lsa, bu Color: Embed Color Profile (11set: BeTpoeHHbli
nseroBoii mpoduab) yordamida bajariladi.

6. Save (Coxpanuts) tugmasini bosing.

Ko‘p qatlamli tasvirlarning nusxalarini gatlamlarsiz avtomatik
tarzda saqlash uchun Maximize backwards compatibility in
Photoshop formats (MakcuManbHasi COBMECTHMOCTh GopMaToB
Photoshop) maydoniga bayrogchani qo‘yish kerak bo‘ladi. Bu
tasvirni boshga formatlarga eksport qilishda juda qo‘l keladi.

1.6. Rastrli tasvirlarning xususiyatlari

Rastr — bu juda kichik yuzaga ega bo‘lgan geometrik figuralar
(piksellar)dan, masalan, kvadratchalardan tuzilgan matritsa. Har
bir piksel o‘z rangiga ega bo‘lishi mumkin. Turli rangdagi piksellar
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to‘plami tasvirni tashkil qgiladi. Piksellarning sirtda joylashishiga
ko‘ra rastrlar turli tiplarga bo‘linadi: kvadrat, to‘g‘ri to‘rtburchak,
doira, geksagonal va boshgalar. Piksellar joylashishini tasvirlash
uchun turli xil koordinata tizimlaridan foydalaniladi. Bu tizim-
larning barchasi uchun umumiy bo‘lgan xossa — ularda piksel
koordinatalari giymatlar diskret gatorini (butun son bo‘lmasligi
mumkin) tashkil qilishidir.

Ko‘pincha butun sonlar koordinata tizimidan foydalaniladi.
Bunda piksellarning boshlang‘ich koordinatasi chap tomondagi
yugori burchakdan boshlanadi.

Resolution (pa3pemenne) — kattalashtirish ko‘rsatkichi bo‘lib,
bir duymli kvadratda nechta piksel joylashganini yoki bir nuqtani
necha marta kattalashtirish mumkinligini ko‘rsatuvchi kattalik
hisoblanadi. U, asosan, rastr grafikasi uchun xosdir. Kattalashtirish
ko‘rsatkichi ortib borishi bilan tasvir sifati va hajmi ham ortib
boradi. Chop etiladigan fayllar uchun u 150 dpi (dots per inch —
bir duymdagi nuqtalar soni)dan kam bo‘lmasligi kerak. Internet
sahifalari uchun yaratilgan fayllar uchun esa 72 dpi qilib belgilangan.

Rastrning geometrik xossalari quyidagilardan iborat:

e ruxsat etiladigan qobillik;

e o‘lcham;

o piksel shakli.

Rastrda ruxsat etiladigan qobillik (pa3pemaromas cnocodHOCTb)
o‘zaro qo‘shni (yonma-yon) joylashgan piksellar orasidagi masofa
bilan xarakterlanadi. Ruxsat etiladigan qobillik bir o‘lchov birligidagi
piksellar soni bilan o‘lchanadi. Eng ko‘p tarqalgan o‘lchov birligi
bo‘lib dpi xizmat giladi. U bir duym (2,54 sm yoki 25,4 mm)
uzunlikdagi piksellar sonini anglatadi. Piksellar o‘lchami bilan ga-
dam kattaligini tenglashtirib bo‘lmaydi. Pikselning o‘lchami ga-
damning kattaligiga teng, undan kichik yoki katta bo‘lishi mumkin.

Rastrning o‘lchami, odatda, gorizontal va vertikal o‘glar bo‘-
yicha joylashgan piksellar soni bilan o‘lchanadi. Shuni aytish
mumkinki, kompyuter grafikasi uchun har ikki o‘glar uchun bir
xil gadamli (ya’ni dpiX=dpiY) rastr qulay hisoblanadi. Bu ko‘pgina
grafik obyektlarni chigarish algoritmlari uchun qulaydir. Aks holda
muammo yuzaga kelishi mumkin.

Rastr piksellarining shakli tasvirni chigarish qurilmasining
xususiyatlari bilan aniqlanadi. Piksellar quyidagi shakllarga ega
bo‘lishi mumkin:
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1. Kvadrat (yoki to‘g‘ri to‘rtburchak shaklidagi piksellar). Ular
o‘lchami bo‘yicha rastr gadamiga teng bo‘ladi (suyuq kristalli
displeylarda).

2. Doira shaklidagi piksellar. Ular o‘lchami bo‘yicha rastr ga-
damiga teng bo‘lmasligi mumkin (printerlar).

1.7. Rastrning ruxsat etiladigan qobilligini baholash

Normal ko‘rish qobilivatiga ega bo‘lgan odamning ko‘zi 1”7 ga
yaqin burchak o‘lchamiga ega obyektlarni farglashi mumkin. Agar
obyektgacha bo‘lgan masofa R uzunlikka teng bo‘lsa, u holda bu
o‘lcham (dP) ni o R ga teng yoy uzunligi sifatida quyidagicha
baholash mumkin:

dP =o - R, (1)

bu yerda oo =1,7453293 - 1072/60 = 2,90888 - 10~ (rad).

Faraz qilish mumkinki, odam rastr diskretligini (gadamini)
ana shu minimal farglash mumkin bo‘lgan o‘lchamga mos ravishda
farglaydi. Boshgacha aytganda, alohida olingan nugqta (piksel) mini-
mal uzunlik dP dan kam bo‘lgan masofaga siljitilsa, u siljitilgan
bo‘lib hisoblanmaydi. Unda ruxsat etiladigan qobillikni rastr si-
fatida gabul gilinmaydigan quyidagi kattalik bilan baholash mumkin:

dpi = 25,4/dP (mm). (2)

1-misol. Agar odam qog‘oz hujjatdagi yozuvni o‘qishi uchun

odatda 30 sm uzoqglikdagi masofadan garaydi deb hisoblansa, u

holda printer uchun ruxsat etiladigan qobillik ganday bo‘lishi
kerak?

Berilgan: R = 30 sm = 300 mm.

dpi —?
Yechish. (l)lifa (2) formulalardan foydalanib yechamiz:
dp= o+ R=290888 - 10* - 300 = 8,726646 - 102,
dpi = 25,4/(8,726646 - 1072) = 291,06 =~ 292.
2-misol. Odatda, displey ekranidan 0,5 m dan kam bo‘lmagan

uzogqlikda o‘tirish tavsiya etiladi. U holda displey ekrani uchun
ruxsat etiladigan qobillik gancha bo‘lishi kerak?

Berilgan: R = 0,5 m = 500 mm.
dpi —?
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Yechish. Xuddi 1-misoldagi kabi amallar bajariladi:

dp=o - R=290888 - 10 - 500 = 1,454441 - 10°;
dpi = 25,4/(1,454441 - 107") =174,6375 = 175.

Agar tasvir o‘lchamlari keragidan katta bo‘lsa, hajmi ham katta
bo‘lishi aniq. Tasvir hajmining katta bo‘lishi gattiq diskda ko‘p
joy egallanishi va kompyuter tomonidan sekin gayta ishlanishiga
olib keladi.

Rastrli grafikada foydalanuvchi har bir pikselga ishlov berish
imkoniga ega bo‘ladi. Tasvirdagi piksellar soni ganchalik ko‘p bo‘lsa,
tasvir shunchalik sifatli bo‘ladi.

Tasvirdagi piksellar zichligi dpi bilan belgilanadi. Gazeta va
shu kabi nashrlarda mazkur ko‘rsatkich odatda 150 dpi, rangli
jurnallarda 300 dpi, fotosurat va kompozitsiyalarda 600—1200 dpi ni
tashkil etadi. Ekranda tasvirlanadigan rasmlar uchun esa 72 dpi
sifat ko‘rsatkichi yetarli hisoblanadi.

Shuni ta’kidlash va eslatib o‘tish joizki, mazkur ko‘rsatkichni
belgilash yoki tanlashda ratsional yondashuv talab gilinadi, chunki
har bir nuqgta xotirada bir bit (agar tasvir og-qora bo‘lsa) joy
egallaydi va ularning soni tasvirda gancha ko‘p bo‘lsa, tasvirning
xotirada egallaydigan hajmi ham shuncha katta bo‘ladi. Masalan,
300 dpi sifatga ega bo‘lgan 2”%X3,5” (” belgisi duymni bildiradi)
(5%9 sm?) o‘lchamdagi kulrangning gradatsiyasida berilgan tasvir
taxminan 630 000 bitni tashkil etadi.

1.8. Rastr tasvirlarni saglash uchun go‘llaniladigan
formatlar

Rastr tasvirlar odatda sigilgan holda saglanadi. Sifatni yo‘qot-
masdan sigishda ortigcha axborotni kamaytirishga asoslangan sigish
algoritmlari gqo‘llaniladi.

BMP (Windows Bitmap) formati — odatda tasvirni sigmagan
holda go‘llaniladi, biroq RLE algoritmini go‘llash mumkin. BMP
formati shaxsiy kompyuter (PS) platformasida qo‘llaniladigan eng
ommaviy grafik fayl formati.

BMP fayllarida tasvirni sigish mavjud emas, ammo rastr tas-
virlarni ifodalashning bunday formati (Device Independent Bitmap),
RLE (Run Length Encoding) siqish algoritmlari qo‘llaniladigan
DIB tipidagi fayllarni saglash uchun go‘llaniladi. RLE algoritmi,
shuningdek, boshqa ommalashgan rastrli grafika formatlarida, ma-
salan PCX da ham qo‘llaniladi.

12



formatli tasvirga hali hech ganday o‘zgartirish kiritilmaganligi va
grafik tahrir dasturi tomonidan bosmaga tayyor emasligi sababli
shunday nomlanadi. RAW formatli rasmda har bir piksel rangi
juda ham aniq va tabiiy holda bo‘ladi; shuning uchun ularni ko‘p
ishlatiladigan jpeg, tiff formatlariga o‘girishdan oldin ranglarga
sifatni yo‘qotmagan holda turli o‘zgartirishlar kiritish mumkin
bo‘ladi (5-rasm).

RAW formati, asl holati RAW formati, avtomatik
o ‘zgartivishlardan keyingi holati

5-rasm. Ayni bir rasmning RAW va JPEG formatlarida saglangan
nusxalarining bir-biridan farglanishi.

14



Boshga grafik formatlar haqidagi ma’lumotlarni tegishli ada-
biyotlar, Internet tarmog‘idagi manbalardan topib, mustaqil o‘rga-
nishingiz mumkin.

5
g Nazorat savollari

E ]

1. Kompyuter grafikasining rivojlanish tarixini aytib bering.

2. Kompyuter grafikasining ganday turlarini bilasiz?

3. Rastr grafikasi to‘g‘risida tushuncha bering.

4. Vektor grafikasi to‘g‘risida tushuncha bering.

5. Fraktal grafikasi to‘g‘risida tushuncha bering.

6. Kompyuter grafikasi turlari ganday farglanadi.

7. Rastrli tasvirlarning xususiyatlari nimalardan iborat?

8. Rastr, kattalashtirish ko‘rsatkichi tushunchalari nimani bildiradi?

9. Ruxsat etiladigan qobillik, rastrning o‘lchami, rastr piksellarining
shakli hagida ma’lumot bering.

10. Rastr tasvirlarni saglash uchun ganday formatlardan foydalaniladi?

15



1I BOB. ADOBE PHOTOSHOP DASTURNING
INTERFEYSI

2.1. Asosiy tushunchalar

Adobe Photoshop dasturi — rastrli tasvirlar (rastr grafik fayllar,
fotosuratlar va h.k.) bilan ishlashga mo‘ljallangan eng ommabop
grafik muharrir hisoblanadi.

Photoshop dasturi ishchi oynasi quyidagilarni o‘z ichiga oladi
(6-rasm):

1. Dastur gatori — dastur va fayl nomini ko‘rsatadi.

2. Menyu qatori — bunda dastur tarkibiga kiruvchi barcha
buyruglar shu menyu bo‘limlari tarkibiga guruhlangan.

3. Options (®opmaTuposanme) paneli — tanlangan asbob yoki
belgilangan obyektga oid buyruglarni ko‘rsatadi.

4. Tools (Muctpymentsi) — uskunalar paneli, dasturda mavjud
bo‘lgan barcha asboblarni o°z ichiga oladi.

5. Status bar (Ctpoka coctrognusi) — holat satri, tanlangan
uskunaga oid ko‘rsatmalarni ko‘rsatadi.

Qo‘shimcha panellar Window menyusidan panel nomini tanlash
orqali ekranga chiqarilib, foydalanuvchiga quyidagi qo‘shimcha
imkoniyatlarni yaratadi:

6. Styles (Ctuan) — ctuuniap, chizilgan obyektlar uchun tayyor
stillardan foydalanib rang berish imkonini beradi.

7. History (Mctopust) — bajarilgan ishlar ketma-ketligini ko‘r-
satib, biror-bir bosgichga qaytish imkonini beradi.

8. Layers (Cnon) — gatlamlar, faylda mavjud barcha gatlamlar
hagida ma’lumot berib, ularni o‘chirish, nusxa olish va xossalarini
o‘zgartirish imkonini beradi.

9. Navigator (Hasuratop) — ko‘rish kattaligi (masshtab)ni
belgilaydi, varagning bir gismidan ikkinchi qgismiga tez o‘tish im-
konini beradi (7-rasm).

Har safar yangi faylni yaratish jarayonida New (Hosblit) mulo-
got oynasi ochilib, foydalanuvchidan quyidagi parametrlarni kiritish
talab gilinadi (8-rasm):

Name (Mma daiina) — fayl nomi, uni ishni boshlashdan oldin
yoki faylni xotiraga saglash vaqtida ko‘rsatish mumkin;

Preser (Pa3mep Oymarm) — qog'oz o‘lchami, uni berilgan
standart asosida tanlash yoki Custom rejimida ixtiyoriy o‘lchamda
o‘rnatish mumkin;

16



Pz v v - Er W | E—rre—— »

AU

AFRNNRT

s p

cTMOZELENEY

| RPTS: FVPI O

oo—|

. :

| 3
[L0o% | [ Doc: 47K/471K P Draw selection from center or subtri

7-rasm. Navigator asbobining qo‘llanilishi.
17



[ pixels =l
|D|><els j
[ pixelsfinch |
Color Mode: [RGB Color ] [ [atthe ks o resootion |
| Irnage Stze:
Background C 1 | whil hd
o ontents: | White Eaf| 22

%) Advanced

Color Profle; | Working RGB: sRGB IEC61966-2.1  v| ‘
Pixel Aspect Ratio: E Square :]

8-rasm. Yangi faylni yaratish jarayonida chigadigan
New (Hossiit) mulogot oynasi.

Width (IlImpuna) — ishchi qogoz bo‘yi;

Height (Beicota) — qog‘oz eni, o‘lchov birligi sifatida mm,
sm, piksel yoki boshqa birliklar ko‘rsatilishi mumkin;

Resolution (pazpemenne) — Kkattalashtirish ko‘rsatkichi;

Background contents (Iletr dona) — orga fon rangi, u oq
(White (benblit)), o‘rnatilgan orga fon rangi (Backround color
(Iset 3agHero ona)) yoki shaffof (Transperense (IIpo3paunblii))
bo‘lishi mumkin.

Image Size (Pazmep n3o0paxenns) sohasida yaratilgan faylning
diskda egallaydigan hajmi ko‘rsatiladi.

2.2. Asboblar paneli

Asboblar (7ools (MucTpymenTs)) panelidagi asboblarni faol-
lashtirish uchun ularning piktogrammalariga sichqoncha bilan
bosish kifoya qiladi. Piktogrammalarning yon tomonida joylashgan
kichkina yo‘naltirgich (strelka)ga bosilsa palitra ochiladi va shu
guruhga kiruvchi asboblarni tanlash imkoniyatiga ega bo‘linadi.

Asboblar bilan ishlashning yana bir qulay tomonlaridan biri —
klaviatura yordamida istalgan asbobni unga mos «gaynog» tugmalar
(tugmalar kombinatsiyasi) yordamida ekranga chigarish imko-
niyatining mavjudligi (buning uchun kerakli asbobga mos keluvchi
harfni yodda saglash kerak bo‘ladi). Agarda siz kerakli tugmalar
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I Auto Select Layer [ Show BoundingBox | Jjo-tr 1y |, =

DT

4

é[—-b 10-rasm. Parametrlar paneli.

LY/ kombinatsiyasini yoddan chigargan bo‘lsangiz, u
?’ e holda kerakli bo‘lgan asbob ustida bir necha
s%. g sekund sichgoncha ko‘rsatkichini ushlab tursan-
i‘ =Y giz, tugmalar kombinatsiyasi hagidagi ma’lumot
e chigadi (9-rasm). Guruhdagi asboblarni ketma-
3 I ket chigarish uchun Shift va shu guruhga mos
S tugma bosiladi. Shu jarayonni Alt tugmasi bosilgan
Q} 6: holda mos asbobning ustiga sichqoncha bilan

bosish orgali ham amalga oshirsa bo‘ladi.
Parametrlar (Options (Ilapametpsi)) panelida
(10-rasm) har bir asbobga mos holda uning pa-

'@ »;
&

) > rametrlari beriladi (masalan, aralashtirish rejimi,
S tiniglilik giymati). Parametrlar paneli ekranning
o0 yugori gismida joylashgan bo‘ladi (bu hagda qo‘l-

lanmaning «Parametrlar paneli» gismida batafsilroq

9-rasm. Opsiva  ma’lumot beriladi). Parametrlar panelidagi

patiell, parametrlar ganday asbob tanlashiga bog‘liq ra-
vishda o‘zgaradi.

Parametrlar panelining chap tomonida joriy asbobning pikto-
grammasi joylashgan bo‘ladi. Agarda piktogramma yonidagi yo‘nal-
tirgichga bosilsa, menyucha paydo bo‘ladi, bu yerdan boshga
asbobni tanlash imkoniyatiga ega bo‘linadi. Bu menyuchadagi ro‘y-
xatni tahrirlasa bo‘ladi, ya’ni kam foydalaniladigan asboblarni olib
tashlasa va ko‘p foydalanadiganlarini unga joylashtirsa bo‘ladi.
Unda har bir asbobning parametrlari, agar u o‘zgartirilmagan yoki
gaytadan kiritilmagan bo‘lsa, o‘zgarmay saglanadi. Bu menyuga
yangi asboblarni yuklash, qo‘shish va saglash amallari maxsus
tugmalar yordamida yoki panel menyuchasi yordamida amalga
oshiriladi (11-rasm). Hamma asboblar uchun oldindan belgilangan
parametrlarni tanlash uchun Reset All Tools (hamma asboblarni
avvalgi holiga gaytarish) buyrug‘i yoki Edit > Preferences >
General (IIpasga > Ycranoeku > O0mme) oynasidagi Reser All
Tools ga sichqgoncha bilan bosiladi.

Edit > Preferences > Display& Cursors (IIpaBka > YCTaHOBKH >
Oto0paxenne m Kypcopsl) oynasidan kursor va asboblar paneli
piktogrammalarining ko‘rinishini belgilash mumkin.
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5 Healing Brush 21 pixels E ®I
T Magnetic Lasso 24 pixels al
T, crop 5 inch x 4 inch 300 pi
&3 Fil with Bubbles Pattern

New Tool Preset...

ve Tool Preset

Delete Tool Freset

v Sort By Tool
T Horizontal Type Myriad Roman 24 pt v Show All Tool Presets

srar Show Current Tool Presets
I~ Current Tool Only
Text Only

v Small List
Large List

Reset Tool
Reset All Tools

Preset Manager...

Reset Tool Presets...
Load Tool Pressts...
Save Tool Presets...
Replace Tool Presets...
At History

Brushes

Crop and Marquee
Text

11-rasm. Parametrlar paneliga asbobni kiritish menyusi.

Agarda asbobdan noto‘g‘ri foydalanilsa, tagiglash piktogrammasi
chiqariladi. Sichgoncha yordamida joriy oynaga chertish orqgali nima
uchun joriy asbobdan foydalanib bo‘linmasligi hagida ma’lumot
olasiz.

12—28-rasmlarda Photoshop dasturi asboblar panelidan asbob-
larni chigarishga oid tasvirlar berilgan. Har bir guruh asboblari
yonida ularni chigarishga mos «gaynog» («ropgyasg KIaBHUIIA»)
tugmalar berilgan. Dastur bilan ishlash jarayonida biror-bir as-
bobga sichqonchani olib borib uni faollashtirishni unga mos «qay-
nog» tugmani bosib amalga oshirsa ham bo‘ladi. Bu foydalanuv-
chini ortigcha harakatlarni bajarishdan xalos etadi va buning nati-
jasida vaqtining tejalishiga olib keladi. Yuqgorida aytib o‘tilganidek,
biror guruh asboblarini Shift tugmasini bosib turib va shu guruhga
mos tugmani ketma-ket bosish bilan shu guruhdagi asboblarni
tartib bilan chigarsa bo‘ladi.

Quyida Asboblar panelidagi asboblarning bajaradigan ishlariga
izohlar berib o‘tamiz (to‘g‘ri qavslar ichida izohlanayotgan asbobga
mos «gaynog» tugma berilgan):
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12-rasm. Move Tool 13-rasm. Marquee Tool to‘rtburchak
asbobini tanlash. yoki oval shaklidagi biror sohani ajratish

asboblari paneli.

1. Move Tool (11epememenue) [V] — tanlash — obyektlarni
belgilash, bir joydan ikkinchisiga ko‘chirish, aylantirish imkonini
beradi (12-rasm).

2. ;'_:]‘ Marquee Tool [M] — belgilash — to‘rtburchak yoki oval
shaklidagi biror-bir sohani belgilash uchun ishlatiladi. Bu asbob tan-
langanda Parametrlar panelida Selection oynasi faollashadi (13-rasm).

Bu yerda: :

1 — New Slection — yangi soha L?@E'I [EI] ‘ Feather: Iﬂrx
belgilash; | | | | |

2 — Add to selection — belgilangan N s
sohaga yangi belgilangan sohani qo‘shish;

3 — Subtract from selection — belgilangan sohadan yangi belgi-
langan sohani kesib olish;

4 — Intersect with Selection — belgilangan sohalarning kesish-
masini olish.

5 — Feather — belgilash yoki kesish chizig‘i qalinligini belgilash.
Kesish chizig‘i qalinligini o‘zgartirish orqali asta-sekin yo‘qolib
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14-rasm. Lasso Tool belgilash 15-rasm. Tasvirning defektlarini
asboblari paneli. o‘chirish asboblari paneli.

boruvchi tasvirlarni hosil gilish mumkin. Bu parametrni kesishni
boshlashdan oldin yoki keyin Select menyusiga murojaat qilish
orgali o‘zgartirish mumkin.

3. P‘ Lasso Tool (Jlacco) |L] — ixtiyoriy belgilash — joriy
gatlamda ixtiyoriy sohani belgilash imkonini beradi (14-rasm).

Uning uch turi mavjud:

birinchisi — erkin qo‘l harakati bilan

| A . . . | Lasso Tool L
belgilash; ikkinchisi — ko‘pburchakli Y Folygonal Lasso Tool i
belgilash; uchinchisi — magnetik lasso — it i

rang chegaralari bo‘yicha belgilash.

4. 1 Crop tool (O0pe3ka) [C] — kesib olish — joriy gatlamdan
belgilangan sohani yoki o‘lchamlari ko‘rsatilgan sohani kesib olish.
Qatlamning bu sohadan tashgaridagi qismi 0°‘z-o‘zidan o°‘chib ketadi.

5. % Magic Wand Tool (MucTpymMenT BOmMeOHOH NANOUKH)
[W] — «sehrli tayoqcha» — gatlamdagi biror rangdagi sohani
belgilaydi. Ranglarning yaqinlik darajasini o‘rnatuvchi 7Tolerance
(Jlomyck) parametriga ega bo‘lib, uning qiymati ganchalik katta bo‘lsa,
biror rangning shuncha ko‘p ottenkalariga mos soha belgilanadi.
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16-rasm. Klonlashtirish 17-rasm. Eraser Tool
asboblari paneli. asboblari paneli.

6. . /" Healing Brush Tool (BoccTanapnusaromas kuctb) [J] —
tiklash mo‘ygalami — rasmning biror gismidan piksellar nusxasini
olib, yangi joyga qo‘yish uchun ishlatiladi. Bunda yangi hosil
bo‘ladigan piksellar yaqgin atrofdagi boshqga piksellarning xususiyat-
laridan kelib chiqib yaratiladi. Bunda kiritilayotgan o‘zgartirishlar
mayinroq chiqadi. Nusxalanayotgan piksellar ularning ustiga
kursorni keltirib, Alt tugmasini bosib turgan holda sichqonchani
bosish orqali tanlanadi (15-rasm).

7. @ Clone Stamp Tool (Komupywomuii mramm) [S] — nusxa
oluvchi shtamp — rasmning biror gismidan piksellar nusxasini
olib, yangi joyga go‘yish uchun ishlatiladi. Tiklash mo‘yqgalami
kabi ishlaydi, biroq undan fargli, yangi hosil bo‘ladigan piksellar
aynan nusxalanayotgan piksellarning o‘zidek bo‘ladi. Nusxala-
nayotgan piksellarni tanlash xuddi tiklash mo‘yqgalamidagi kabi
bajariladi (16-rasm).

8. .é?,\ Eraser Tool (JJactux) [E] — o‘chirg‘ich — joriy qatlamda
biror sohani o‘chirish. Shift tugmasini bosib turgan holda sichqon-
chani bosib nuqtalarni bir-biri bilan bog‘lash mumkin (17-rasm).

23



Quyidagi turlari mavjud:

22 Background Eraser Tool (JIactux dona) [E] — orga rang
o‘chirg‘ichi — orga rangni o‘chiradi.

E Magic Eraser Tool (Bommeonsiii gactuk) [E] — «sehrli»
o‘chirg‘ich — o‘xshash rangli sochalarni o‘chirish uchun ishlatiladi.

Ushbu asbob guruhiga kiruvchi asboblar tanlanganda Parametr-
lar panelida quyidagi parametrlarni kiritish mumkin bo‘ladi:

Mode (Pexum) — o‘chirg‘ich ko‘rinishini tanlash, bunda
quyidagi ko‘rinishlar tanlanishi mumkin: mo‘yqalam (Paintbrush —
Kucts), acrograf (Airbrush — Asporpad), galam (Pensil — Kapan-
nam), blok (Block — Bbaok). Blok ko‘rinishida sichqoncha kursori
16x16 pikselli kvadrat shaklida bo‘ladi. Blok kattaligi o‘zgarmaydi,
shuning uchun tasvirni 1600% 1i masshtabda ko‘rganimizda ushbu
blok rasmning 1 piksel kattaligiga teng bo‘ladi;

Tolerance (Jlomyck) — sezuvchanlik, rang o‘chirishda sezuv-
chanlikni ozgartirish;

Protect Foreground Color (OcHoBHO#W 1BeT) — asosiy rangni
o‘chirilishdan himoyalash;

Limits (Orpanmvennsi) — cheklashlar, quyidagi parametrlari
mavjud: Discontiguous (Bce mukcean) — mo‘ygalam ostida uchray-
digan tanlangan rangdagi barcha piksellarni o‘chirish; Contiguous
(Cmexnble mukceabl) — tanlangan rang va unga bo‘gliq sohalarni
o‘chirish; Find Edges (Bvineienme KpaeB) — tanlangan rangga
ega sohalarni o‘chirish, bunda shaklning chegaralari yaxshi saglanadi;

Sampling (Cemmuimnr) — o‘chiriladigan rang tanlash holatini
o‘zgartirish;

Anti-Aliased (Crnaxusanne) — chegaralarning yoyilishi, o‘chi-
riladigan socha chegaralari holatini o‘zgartirish;

Use All Layers (CemmupoBats Bce caon) — «sehrli» o‘chir-
g‘ichning hamma qatlamlarga yoki fagat asosiy gatlamga ta’sir
etishini ta’minlaydi;

Opacity (Henpo3paunoctb) — o‘chirish kuchini belgilaydi:
100% da barcha piksellar o‘chiriladi, undan kam bo‘lganda foiz
miqdoriga garab ayrim piksellargina o‘chiriladi.

9. Blur Tool (PasmmiTe) [R] — kontrastni kamaytirish
yoki ranglarni yoyish uchun ishlatiladi (18-rasm).

/| Sharpen Tool (Pe3kocts) [R] — kontrastni ko‘paytirish
yokmnglami aniqlashtirish asbobi.
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18-rasm. Tasvir chegaralari 19-rasm. Tasvir ranglarining och-
anigligini nazorat giluvchi to‘gligini o‘zgartirish asboblari
asboblar paneli. paneli.

E Smudge (PasmbBatenp) [R] — rang yoyish yoki tortish asbobi.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin
bo‘ladi:

Brush (Kuctb) — gqalam (mo‘yqalam) turi va galinligini tanlash;

Mode (Pexxum) — ranglarni o‘zgartirish holatini sozlash;

Pressure (Haxum) — yoyish kuchini o‘zgartirish;

Use All Layers (CemmumpoBaTh Bee cion) — yoyilish hamma gat-
lamlarga yoki fagat asosiy bo‘lgan gatlamga ta’sir etishini ta’minlaydi;

Finger Painting (PucoBanue najbieMm) — rangga botirilgan
barmoq bilan chizish effektiga o‘tish.

ochartirish asbobi (19-rasm).
gj Burn Tool (3atemuutenn) [O] — tasvir ranglarini to‘gar-
tirish asbobi.
Sponge Tool (I'yoka) [O] — biror soha ranglarining och-
to‘gligini mayin o‘zgartirish asbobi.
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20-rasm. Chiziglar chizish 21-rasm. Tasvirni avvalgi holatga
asboblari paneli. gaytarish asboblari paneli.

11. Iﬂ Pensil Tool (Kapannam) [B] — galam — galam yordamida
chizish (20-rasm).

ﬂ Brush Tool (Kuctb) [B] — mo‘yqalam — asosiy chizish
asbobi. Mo‘yqalamdan foydalangan vaqtda Shift tugmasini bosib
turgan holda sichqoncha bilan chizsak, u holda to‘g‘ri chiziglar
chiziladi. Shift tugmasi yordamida sichqonchani bosib, hosil bo‘lgan
nugtalarni bir-biri bilan to‘g‘ri chiziglar orgali bog‘lash mumkin.
Mo‘ygalam bilan chizilgan chiziglarning chegaralari gqalamda
chizilgan chiziq chegaralariga garaganda aniq bo‘lmaydi.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:

Brush (Kuctb) — qalam turi va qalinligini tanlash;

Mode (Pexum) — chiziglarni rasm ustiga qo‘yilish turini tanlash;

Opacity (Henpo3paunocts) — chiziglarning ko‘rinish darajasini
o‘zgartirish;

Auto Erase (AsrocTpanne) — old fon rangini o‘z ichiga oluvchi
sohalar ustidan orga fon rangida chizish imkonini beradi;

Wet Edges (Moxkpsie Kpasi) — «ho‘l chegaralar» — mo‘yqalam
chetlarida ranglarni kuchaytirib, xuddi akvarel bilan chizish effekti-
ni beradi.
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12. ﬁ History Brush Tool (ApxusHas kuctb) [Y] — avvalgi
holatga gaytish — bu asbobni tanlashdan oldin gaytish kerak bo‘lgan
holatni History (Mcropusi) yordamchi sohasida belgilashingiz kerak.
So‘ngra ushbu asbob bilan shu holatdan keyingi hamma harakat-
larni ko‘rsatilgan sohada o‘chirishingiz mumkin bo‘ladi (21-rasm).

G Art History Brush Tool (ApxwBHas XynoXecTBeHHAS! KHCTE)
[Y] — avvalgi holatga badiiy gaytish — avvalgi holatga gaytish
asbobiga o‘xshash bo‘lib, farqi oldingi holatga gaytishda turli
maxsus effektlardan foydalanish imkoniyati mavjud.

Parametrlar panelida quyidagi parametrlarni Kiritish mumkin:

Brush (Kuctb) — qalam turi va qalinligini tanlash;

Mode (Pexxum) — chiziglarni rasm ustiga qo‘yilish turini tanlash;

Opacity (Henpo3paunoctsb) — chiziglarning ko‘rinish darajasini
o‘zgartirish;

Style (Ctunib) — maxsus effektni tanlash;

Tolerance (Iomyck) — ranglardan foydalanish, 100% da —
tasvirdagi ranglar, 0% da — ranglar ixtiyoriy olinadi;

Area (JInametp) — asbobning ta’sir etish sohasini tanlash;

&[ Airbrush (Asporpad) [J] — puliverizatorga o‘xshash chizish
asbobi. Agar aerografdan foydalanish vaqtida Shift tugmasini bosib
sichgoncha bilan chizsak, u holda to‘g‘ri chiziglar chiziladi. Shift
tugmasi yordamida sichgonchani bosib, nuqtalarni bir-biri bilan
bog‘lash ham mumkin.

13. [@| Gradient Tool (Tpapuent) [G] — gradiyent rang berish
yoki bitta rangdan boshqgasiga o‘tish rangi bilan tanlangan sohani
to‘ldirish (22-rasm).

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:

Gradient Editor (Penaktuposanue rpaguenta) — mavjud gra-
diyent turlarini tanlash va yangi gradiyent rang hosil qilish paneli;

Linear Gradient (JIuneiinblii rpaament) — ajratilgan sohani
chizigli gradiyent bilan bo‘yash;

Radial gradiyent (Pagmanbublii rpaguent) — ajratilgan sohani
radial gradiyent bilan bo‘yash;

Angle gradiyent (KonycoBuaHblii rpajmenT) — ajratilgan sohani
konussimon gradiyent bilan bo‘yash;

Reflected gradiyent (3epkanbHblii rpaaMenT) — ajratilgan sohani
oynadagi kabi akslantirish gradiyenti bilan bo‘yash;

Diamond gradiyent (PoMOoBWAHBI TpaameHT) — ajratilgan
sohani rombsimon gradiyent bilan bo‘yash;
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22-rasm. Ajratilgan sohani bo‘yash 23-rasm. Tasvirni avvalgi holatga
asboblari paneli. gaytarish asboblari paneli.

Reverse — gradiyentdagi ranglarni teskari akslantirish;

Dither — gradiyentdagi ranglarning bir-biriga kamroq sondagi
o‘tishlari evaziga tekisroq gradiyent olish;

Opacity (Henpospaunoctb) — gradiyentning shaffofsizligi
miqgdorini o‘rnatish.

&Yy, Paint Bucket Tool (3anmeka) [G] — ajratilgan sohani
bitta rang yoki nagsh bilan bo‘yash.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:

Fll (3aimeka) — rang bilan bo‘yash turini tanlash;

Opacity (Henpo3paunoctb) — rang bilan bo‘yalgan sohaning
ko‘rinish darajasini o‘zgartirish;

Tolerance (Jlonyck) — sezuvchanlik — rang bilan bo‘yashda
chegaralar sezuvchanligini o‘zgartirish;

Mode (Pexxum) — rangning tasvir ustiga qo‘yilish turini tanlash;

Anti-Aliased (Cranaxusanue) — chegaralarning yoyilishi — rang
bilan bo‘yaladigan soha chegaralarining mayinroq chigqishi;

Contiguous (Cmexuble mukcenbl) — fagat ajratilgan sohani rang
bilan bo‘yash;

All Layers (Bee caomn) — ajratilgan soha chegarasida barcha
gatlamlarni bo‘yashni amalga oshirish.
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24-rasm. [zohlar qo‘shish 25-rasm. Notes asbobi yordamida
asboblari paneli. yaratilgan izoh.

14. E Pen Tool (Ilepo) [P] — pero — sichqoncha yordamida
nugtalar orqali shakl yaratish imkonini beradi (23-rasm).

Q_l Freeform Pen (IIpoussosbroe nepo) [P] — ixtiyoriy pero —
sichgonchani bosib turib ixtiyoriy harakatlar bilan shakl yaratiladi.

ﬂ Add Anchor Point (Jlo0BATH TOYKY) — yangi nuqta qo‘-
shish — sichqoncha yordamida shaklga yangi burilish nugtasi qo‘shiladi.

| Delete Anchor Point (Ypamats Touxy) — nugtani o‘chirish —
sichqoncha yordamida shakldagi burilish nugtasi o‘chiriladi.

E] Convert Point (1IpeoGpa3oBath TOYKY) — nugtani o‘zgar-
tirish — shakl nugqtalarining joylashishini o‘zgartirish (cho‘zish).

15. % Notes (3amerkm) [N] — izoh (eslatma) qo‘shish —
rasmning ixtiyoriy sohasiga matnli izoh qo‘shish (24-rasm). Bunda
Adobe Acrobat dasturi formatiga ega bo‘lgan matnli izohlar kiritish
mumkin.

Bu eslatmalar bosmadan chiqarilmaydi. Ular fagat buyurtma-
chiga, tipografiyaga va h.k. kerakli bo‘lgan ma’lumotlarni berish uchun
xizmat qiladi. Izoh belgisiga bosish orgali paydo bo‘lgan oynada
(25-rasm) berilgan izoh matnini ko‘rish, uni gayta tahrirlash mumkin.
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26-rasm. Matn bilan ishlovchi 27-rasm. Turli geometrik shakllar
asboblar paneli. chizish asboblari paneli.

‘}?!'J Audio Annotation (3BykoBoe ommcamme) [N] — ovozli

izohlar — rasmning ixtiyoriy sohasiga ovozli izoh qo‘shish.

16. T | Type (Teker) — matn — matnlar bilan ishlovchi asbob
paneli (2_6jrasm).

17. Q Rectangle (Ilpamoyroabhuk) [U] — to‘rtburchak —
to‘rtburchak chizish (27-rasm).

gj Rounded Rectangle (Cxpyraennblii npaMoyroabnuk) [U] —
aylanasimon to‘rtburchak — aylanasimon to‘rtburchak chizish.

Bu asbob tanlanganda Parametrlar panelida chigadigan Radius
maydonida burchaklar radiusini kiritish mumkin.

a Ellipse (Bnmanc) [U] — aylana — aylana, oval chizish.
(3] Polygon (Muoroyromsmuk) [U] — ko‘pburchak — kop-
burchak chizish. Bu asbob tanlanganda Parametrlar panelida chi-

gadigan Sides (Croponbt) maydonida ko‘pburchak tomonlarining
sonini ko‘rsatish mumkin.
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'\ Line (Jlumast) [U] — chiziq —
to‘g‘ri chiziq chizish. Chiziq galinligini
Weight (Tonumna) maydonida ko‘r-
satish mumkin.

3| Custom Shape (IIpoussoms-
Hasi ¢purypa) [U] — maxsus shakllar,
turli tayyor shakllar chizish. Para-
metrlar panelida chiqadigan Shape
(®urypa) maydonida kerakli shaklni
tanlash mumkin.

18. | # Eyedropper (Ilmnerka)

"g
12|
Re-

Moy CRER &L
D= sy &Y

BN\

;- fzy.dropp.r'rw |
2 ) @ Color Sampler Tool i
[I] — tomizg‘ich — tasvirning istalgan 4 = 75 Wessure Tool | ‘
joyiga bosib, shu joyga mos keluvchi %
piksel rangini asosiy rang qilib tanlash ™
imkoniyatini beradi (28-rasm). Agar /-
tanlangan rangni fon rangi qilib ta- 1 J-
yinlash kerak bo‘lsa, u holda rang tan- TR
lanayotganda Alt tugmasini bosib tu-
rishingiz shart bo‘ladi. ZV{; ‘;‘;‘;‘) f;}::%lﬁ;’nb;ggsg?
\zﬂ Color Sampler (CpaBneHune asboblar paneli.

nsetoB) [I] — ranglami solishtirish —
Info (Mndo) yordamchi oynasida 4 tagacha nugtaning ranglari
hagidagi ma’lumotlarni ko‘rish imkoniyatini beradi. Nugtalarni
sichgoncha yordamida qo‘yamiz, biror qo‘yilgan nugtani o‘chirish
uchun esa Alt tugmasini bosib turib, sichqonchani shu nuqta
ustiga olib kelib (bunda kursor qaychi shaklini oladi) bosish kerak.
@ Measure (M3mepurens) [I] — chizgich — rasmdagi maso-
falarni aniglash uchun go‘llaniladi. Sichgonchani bosib biror nuq-
tani kesmaning boshi qilib, oxirini Alt tugmasini bosib belgilasa
bo‘ladi, bunda hosil bo‘lgan kesmaning vertikal bilan hosil gilgan
burchagini Info (Mudo) yordamchi oynasida ko‘rish mumkin.
Shu amalni ikki marta takrorlab, ikki chizigli siniq chiziq hosil
gilish mumkin. Bunda hosil bo‘lgan siniq chiziq transportir vazi-
fasini bajarib, hosil bo‘lgan burchakning o‘lchamini ko‘rsatadi.
Parametrlar panelida quyidagi ma’lumotlarni ko‘rish mumkin:
tanlangan boshlang‘ich nuqta koordinatalari (X, Y);
birinchi nuqgtadan ikkinchisigacha bo‘lgan masofa — vertikal
va gorizontal bo‘yicha (W, H);
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X o‘qi bo‘yicha egilish burchagi (A);

birinchi nuqgtadan ikkinchisigacha bo‘lgan masofa (D1);

birinchi nugtadan uchinchisigacha bo‘lgan masofa (transpor-
tirdan foydalanilganda) (D2);

Clear (Ounctka) — chizg‘ichni o‘chirish tugmasi.

19. @ Hand (Pyka) [H] — qo‘l — agar rasm ekranga to‘liq
sig‘masa, u holda bu asbobni tanlab sichqoncha yordamida rasmni
siljitish mumkin bo‘ladi. Rasmni ekranning o‘ng va pastki gismida
joylashgan ko‘rib chiqish yo‘naltirgichlari orgali ham siljitish mum-
kin, biroq Hand asbobi yordamida buni amalga oshirish qulayroq.
Uni xohlagan vaqtda (garchi boshga asbob ishlatilayotgan bo‘lsa
ham) probel tugmasini bosib turib vaqtincha faollashtirish mum-
kin. Probel tugmasi qo‘yib yuborilishi bilan yana avvalgi asbob
faollashadi.

Parametrlar panelida quyidagi ma’lumotlarni ko‘rish mumkin
bo‘ladi:

Actual Pixels (Peansnsiii pasmep) [Ctrl+Alt+0] — rasmni 100%
hajmda ko‘rsatish holatiga o‘tish tugmasi, ushbu holatda rasmning
1 pikseli ekrandagi 1 pikselga mos keladi.

Fit On Screen (Bo Bec 3kpan) [Ctrl+0] — rasmni butun
ekranga sig‘dirish holatiga o‘tish tugmasi. Bu tugma yordamida
rasm oyna hajmigacha sig‘adigan qilib o‘zgartiriladi (kattalashtiriladi
yoki kichiklashtiriladi).

Print Size (Pa3zmep orTcka) — printerdan bosmaga chigganda
ganday chiqgishini ko‘rsatuvchi tugma.

20. E‘ Zoom (JIyna) [Z] — lupa — bu asbob orqali ekrandagi
tasvirni ko‘rish masshtabini o‘zgartirish mumkin. Tasvirni
kattalashtirish uchun sichqoncha bilan tasvirning kerakli gismiga
kursorni olib borib bir marta bosish kerak yoki kattalashtirish
kerak bo‘lgan sohani sichqonchani bosib turib tanlash kerak. Agar
kichiklashtirish kerak bo‘lsa, u holda Alt tugmasini bosib turib
sichqoncha bilan rasmga bir marta bosamiz. Ushbu harakatlarni
«gaynoqg» tugmalar orgali ham bajarish mumkin: Zoom In
[Ctrl+Plus] — rasmni kattalashtirish, Zoom Out [Ctrl+Minus] —
rasmni kichiklashtirish, Actual Pixels [Ctrl+Alt+0] — rasmni 100%
hajmda ko‘rsatish holatiga o‘tish tugmasi, Ctrl+Alt+Plus — rasmni
oyna bilan birgalikda kattalashtirish, Ctrl+Alt+Minus — rasmni
oyna bilan birgalikda kichkinalashtirish, Fit On Screen [Ctrl+0] —
rasmni butun ekranga sig‘dirish holatiga o‘tish.
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Parametrlar panelida quyidagilarni kiritish mumkin:

Resize Windows To Fit (HacTpauBaTh pasmMep OKOH) — rasmni
0‘zi ochilgan oyna bilan birga o‘zgartirish holatini tayinlash.

Ignore Palettes (be3 ywera maamtp) — oyna kattalashganda
o‘ng tomondagi yordamchi sohalar orgasiga o‘tish mumkinligi
yoki mumkinmasligini tayinlash.

21. E Ushbu tugma bir nechta amallarni bajaradi:

1) Set Foreground Color (BuiOpaTh mBeT mepemHoro IiaHa) —
asosiy rangni tanlash — yuqorida turgan kvadrat shaklidagi rang
ko‘rsatkichini bir marta bosib, hosil bo‘lgan oynadan asosiy rangni
tanlaymiz.

2) Set Background Color (Buiopats nper dona) — fon (orga
plan) yoki ichki rangni tanlash — orqgada turgan rang ko‘rsatkichini
bir marta bosib, hosil bo‘lgan oynadan fon rangini tanlaymiz.

3) Switch Foreground and Background Colors (Ilepekmouutb
1BeT nepeHero mwiaHa u nsera ¢ona) [X] — asosiy va fon ranglarini
o‘zaro o‘zgartirish — asosiy va fon ranglari ko‘rsatkichlari ustida
joylashgan strelka yordamida asosiy va fon ranglarini o‘zaro o‘zgar-
tirish mumkin.

4) Default Foreground and Background Colors (YcTaHoBUTD
IBeT MepeaHero IiaHa W nsera ¢oHa mo ymoauanmdw) [D] —
asosiy va fon ranglarini, mos ravishda, qora va oq rangga o‘tkazish —
asosiy va fon ranglari ko‘rsatkichlari tagida joylashgan kichkina
belgilar yordamida asosiy rangni — qora, fon rangini esa oqqga
o‘tkazish mumkin.

22, Screen Mode (Pexum 3kpana) [F] — ekran holati —
ekran holatini o‘zgartirish tugmasi. Birinchi holat — Standard
Screen Mode (Crpanpaptblil) — standart ekran holati — rasm
oynasi, menyu satri, asboblar paneli va yordamchi panellar ko‘ri-
nadigan holat; ikkinchi holat — Full Screen Mode with Menu Bar
(IToIHO3KpAHHDBIH CO CTPOKOI MeHI0 mporpaMmbl) — dastur menyusi
bor to‘liq ekran holati — dastur gatori, oyna chegaralari, ma’lu-
motlar satri va ko‘rib chigish yo‘naltirgichlari ko‘rinmaydi; uchinchi
holat — Full Screen Mode (IloanosakpanHbiil) — menyusiz to‘liq
ekran holati — bu holatda ikkinchi holatga ko‘rinmaydigan ele-
mentlarga qo‘chimcha yana menyu satri ham ko‘rinmaydigan ek-
ran holati.
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23. el Jump to ImageReady (Ilepekmounthea B Image-
Ready) [Ctrl+Shift+M] — ImageReady dasturga o‘tish — joriy
rasmni ImageReady dasturiga o‘tkazadi va uni ushbu dasturda
tahrirlashni davom ettirishga imkoniyat beradi.

@ Nazorat savollari

]

1. Adobe Photoshop dasturi ishchi oynasi gaysi elementlardan tashkil
topgan?

2. Qo‘shimcha panellarning vazifalari hagida aytib bering.

3. Asboblar panelidagi birinchi gator asboblarining ishlash prinsipini
tushuntiring.

4. Asboblar panelidagi ikkinchi gator asboblarining ishlash prinsipini
tushuntiring.

5. Parametrlar paneli ganday vazifani o‘taydi?

6. Adobe Photoshop dasturida necha xil ekran holatlari mavjud? Ularga
izoh bering.
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IIT BOB. TASVIR SOHASINI BELGILASH VA
QAYTA ISHLASH

Sohani belgilash (ajratish) — bu fotomontajning eng asosiy
amallaridan biri hisoblanadi. Sohani belgilash asboblari bilan avvalgi
mavzularda tanishganmiz.

Sohani belgilash asboblari bilan rasmning ixtiyoriy sohasini
belgilaganimizda, u punktir chiziglar bilan chegaralangan holda
ko‘rinadi. Shu tanlangan sohaga yana boshqga ixtiyoriy sohani
go‘shish uchun Shift tugmasini bosib turgan holda go‘shimcha
sohani belgilaymiz (bunda ushbu asbobga mos kursor holatining
pastki o‘ng burchagida «+» ishorasi paydo bo‘ladi). Shu tanlangan
sohadan bir gismini chigarib tashlash uchun Alt tugmasini bosib
chiqarilishi kerak bo‘lgan sohani belgilaymiz (bunda ushbu asbobga
mos kursor holatining pastki o‘ng burchagida «—» ishorasi paydo
bo‘ladi).

Endi bu amallarga doir bo‘lgan Select (Bvinenenue) menyusi
buyruglari bilan yaginroq tanishib chigamiz.

All (Bce) [Ctrl+A] — barchasini belgilash — rasm egallagan
butun sohani belgilash.

Deselect (Pazormenntsb) [Ctrl+D] — belgilashdan chigarish —
belgilangan sohani bekor qilish.

Inverse (Mnsepcust) — tanlashni o‘girish — tanlangan sohani
belgilashdan chigarib, belgilanmagan sohani belgilash.

Color ([Inanazon uperoB) — rang asosida belgilash, «sehrli
tayoqcha» asbobiga o‘xshash ishlaydi.

Feather (PactymeBka) — chegaralar — belgilangan sohaning
chegaralari galinligini tayinlash.

Modify (M3menntn) — o‘zgartirishlar — belgilangan sohani turli
holatlarda o‘zgartirish. Asosiy holatlar: Border (Pamka) — chega-
ralar — belgilangan soha chegaralari bo‘yicha siz ko‘rsatgan hajmda
belgilangan ramkali sohani yaratadi. Smooth (Craaxusanue) —
chegaralarni silliglashtirish — belgilangan schaning burchaksimon
(zinapoya shaklidagi) chegaralarini silliglashtiradi. Expand (Pacta-
HyTh) — kattalashtirish — belgilangan sohani siz ko‘rsatgan uzun-
likda proporsional ravishda kattalashtiradi. Contract (CeepHyTb) —
kichiklashtirish — belgilangan sohani siz ko‘rsatgan masofada pro-
porsional ravishda kichiklashtiradi.
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Grow (CmexHble mukcesbl) — yonidagilarni qo‘shish —
belgilangan soha yonida joylashgan o‘xshash ranglarni ham belgi-
langan sohaga qo‘shish.

Similar (Cxoxbie mukceanl) — o‘xshashlarni qo‘shish —
ixtiyoriy joyda joylashgan o‘xshash ranglar sohalarini belgilangan
sohaga qo‘shish.

Transform Selection (IIpeoGpa3oBats Beineaenne) — belgilangan
sohani o‘zgartirish — belgilangan sohani ixtiyoriy holatda o‘zgar-
tirish.

Tanlangan sohaning shaklini o‘zgartirish va u bilan turli amal-
larni bajarish mumkin. Buni Edit (PenaktupoBath) menyusi
buyruglari yordamda amalga oshirsa bo‘ladi. Masalan, belgilangan
sohani xotiraga olish yoki qirgib olish uchun Copy (KonupoaTtsb),
Cut (Bouipe3atb), xotiradan qo‘yish uchun esa Paste (BcTaButb)
buyruglarini bajarish kerak.

Qolgan buyruglar bilan tanishaylik:

Free Transform (Csoboanoe npeodpazoBanne) — erkin o‘zgar-
tirish — ushbu buyruq tanlanganda belgilangan soha yoki rasm
chegaralarida maxsus nugtalar paydo bo‘ladi. Ular yordamida bel-
gilangan sohani cho‘zish, giyshaytirish, aylantirish va boshga hara-
katlarni bajarishimiz mumkin.

Transform (IlpeoOpa3osanme) — o‘zgartirish — ushbu band
tanlanganda unga kiruvchi quyidagi buyruglar chigadi:

Scale (MacmradnpoBanme) — gorizontal va vertikal bo‘yicha
o‘lchamlarni o‘zgartirish;

Rotate (IloBopot) — aylantirish;

Skew (Haxkaon) — burchaklardan birini tortish;

Distort (Mickaxkenne) — bir nechta burchakni tortish;

Perspective (IlepcnektuBa) — perspektiva effektini qo‘llash;

Numeric (Mckaxenne) — berilgan chiziglar yordamida ozgar-
tirish;

Rotate 180° (1losopot Ha 180°) — 180° ga burish;

Flip Horizontal (Otpa3uth nmo ropusoHTanmm) — gorizontal
bo‘yicha akslantirish;

Hip Vertical (Otpasutb no BepTukasm) — vertikal bo‘yicha
akslantirish.

Endi, sohani belgilashga doir topshirigning bajarilishini ko‘rib
chigamiz, ya’ni otkritka yasaymiz. Bu topshirigni bajarish algoritmi —
ketma-ketligi bo‘yicha quyidagi amallarni bajaramiz:
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1) fayllarni ochish buyrug‘i (File > Open) yordamida mavzuga
doir ikkita tasvirni ochamiz (29-rasm);

29-rasm. Topshiriq uchun tanlangan tasvirlar.

2) 2-fayl (ayigli rasm)da [} Marquee Tool asbobini tanlab,
parametrlar panelida paydo bo‘lgan Feather (PacTymeBka) may-
doniga belgilangan sohaning chegaralari galinligini 20 pik qilib
belgilaymiz, Style (Ctnib) maydonida normal holatiga otib, kerakli
sohani belgilaymiz;

3) uni nusxalaymiz (Copy) va 1-faylga qo‘yamiz (Paste);

4) nusxalagan obyektni kerakli joyga joylashtiramiz;

5) Adjust (KoppekTupoka) buyrug‘i yordamida rasmning rang-
lari ustidan turli tahrirlash amallarni bajaramiz;

7) gorizontal matn asbobini tanlab, parametrlar panelida paydo
bo‘lgan maydonlarga kerakli ma’lumotlarni kiritib, yoysimon ko‘ri-
nishdagi matn yaratamiz;

8) Brush [B] asbobini tanlab, Brush maydonidan 74-raqamli
barg ko‘rinishidagi mo‘ygalamni tanlab, uning yordamida tasviri-
mizning ba’zi joylariga barglar rasmini qo‘yib chigamiz;

9) ko‘rinadigan gatlamlarni birlashtiramiz (faol bo‘lgan barcha
palitralarni, asboblar panelini Tab tugmachasi bilan vaqtincha ek-
randan olib turish mumkin, bu hosil bo‘lgan tasvirimizni yaqgqol
ko‘rish imkonini beradi; Tab tugmasi gayta bosilsa, palitralar yana
chiqadi);

10) hosil bo‘lgan tasvirni jpg formatida saglash bilan topshi-
rigni yakunlaymiz (30-rasm).

Photoshop dasturining birinchi darajali vazifalaridan biri belgi-
lash funksiyasidir, u kerakli tasvir sohasini boshqgalaridan ajratish
imkonini beradi, ya’ni fagat belgilangan obyektni goldirib, bosh-
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30-rasm. Hosil bo‘lgan otkritka tasviri.

galarini olib tashlaydi. Odatda, schalarni belgilash uchun asboblar
panelida joylashgan maxsus belgilash asboblaridan foydalaniladi.
Biroq berilgan operatsiyani Extract (M3Baeun) — chigarib olmoq
filtri yordamida ham bajarish mumkin. Filtrni ishlatishdan oldin
tasvirni keyinchalik o‘zgartirishga imkon bo‘lishi uchun Layers
(Cnomn) gatlamlar palitrasida gatlamning piktogrammasi garshisida
yopilgan qulf shaklidagi tagiglash belgisi bo‘lsa, u holda ikki marta
sichgonchaning chap tugmachasini bosib, paydo bo‘lgan mulogot
oynasida OK tugmasini bosing. Shundan so‘ng, Filter (®uibtp) >
Extract (M3Baeun) buyrug‘ini tanlang. Ushbu filtr obyektning
biror sohasini ajratishga yordam beradi, bunda shu obyektning
golgan gismi o‘chirib tashlanadi. Filtrning mulogot oynasi oynaning
chap gismida joylashgan belgilash va tasvir bo‘yicha navigatsiya
asboblarini hamda o‘ng qismida joylashgan filtrni sozlash panelini
0‘z ichiga oladi.

Yugorida ko‘rib chiqgan filtr bo‘yicha ikkita tasvirni birlashtirib,
bir holatdan boshqga holatga (qish faslidan yoz fasliga) o‘tishni
misol tariqasida ko‘rib chigamiz. Buning uchun quyidagi amallar
algoritmini bajaramiz:
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31-rasm. Topshirig uchun tanlangan gish va yoz fasllari aks etgan tasvirlar.

1. Ikkita tasvir olamiz, ya’ni import qilamiz (31-rasm).

2. Qish faslidagi ayigni yoz fasliga o‘tkazamiz. Ayiq rasmiga
turli tuzatishlar kiritish lozim, chunki unda nugsonlar mavjud. Bosh
ko‘rinishni belgilab, orga fonni olib tashlash va ayiq rasmini yoz
fasliga qo‘yish kerak bo‘ladi. Buning uchun Filter (Pwmstp) > Extract
(M3Bneun)buyrug‘ini tanlaymiz (32-rasm) va yuqoridagi ishlarni
amalga oshiramiz. Shuni eslatib o‘tish kerakki, tasvir ustidan ishlov
beriladi, shuning uchun gatlamdagi qulfni olib tashlash kerak bo‘ladi.

3. Extract (M3Bneun) filtrining mulogot oynasidagi asboblar
va sozlash panelidan foydalanib, bosh ko‘rinishni orga ko‘rinishdan
ajratamiz (33-rasm).

4. Preview (Ilpensaputenpblii mpocMotp) — oldindan ko‘rish
tugmachasini bosib, bajarilgan belgilash ma’qul bo‘lsa, OK tug-
machasini bosamiz va hosil bo‘lgan tasvirni olamiz (34-rasm).

5. Ikki obyekt (ayiq va daraxt)ga ishlov beramiz — yoz fasliga
mos kelmagan nugsonlarni, masalan, gorni olib tashlaymiz. Buning
uchun asboblar panelidagi asboblardan foydalanib, tegishli tuza-
tishlarni amalga oshiramiz (35-rasm).

6. So‘ngra hosil bo‘lgan tasvirning fonini — yoz faslining tasvirini
yaratamiz, buning uchun yoz faslini ayiq joylashgan faylga yangi
gatlam qilib o‘tkazamiz (36-rasm).

7. Tasvirni jpg formatida saqlaymiz (37-rasm).
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32-rasm. Extract (U3Bnewn) filtrining mulogot oynasi.

PSP e W M- | E—— > iR

GErlenkN AT
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34-rasm. Belgilashdan keyin hosil bo‘lgan tasvir.
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35-rasm. Nugsonlarni olib tashlagandan keyingi tasvir.
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5
u Nazorat savollari

1. Adobe Photoshop dasturida
biror sohani belgilash ganday amalga
oshiriladi?

2. Select menyusi buyruglari ha-
gida ma’lumot bering.

3. Free Transform buyrug‘ining
vazifasi nimadan iborat?

4. Extract buyrug‘i yordamida
ganday amallarni bajarish mumkin?

37-rasm. Natijada hosil bo‘lgan
tasvirning ko‘rinishi.
42



1V BOB. MO‘YQALAM VA RASSOMCHILIK
ASBOBLARI

4.1. Mo‘yqalamlarni tanlash, yuklash va sagqlash

_j_’J Brush Tool (Kuctb) [B] — mo‘ygalam — asosiy chizish

asbobi. Mo‘yqalamdan foydalangan vaqtda Shift tugmasini bosib
turgan holda sichqoncha bilan chizsak, u holda to‘g‘ri chiziqlar
hosil bo‘ladi. Shift tugmasi yordamida sichqonchani bosib, hosil
bo‘lgan nugqtalarni bir-biri bilan to‘g‘ri chiziglar orgali bog‘lash
mumkin. Mo‘ygalam bilan chizilgan chiziglarning chegaralari aniq
bo‘lmaydi.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:

Brush (Kuctb) — galam turi va galinligini tanlash;

Mode (Pexum) — chiziglarni rasm ustiga go‘yilish turini
tanlash;

Opacity (Henpo3zpaunoctb) — chiziglar ko‘rinish darajasini
o‘zgartirish;

Auto Erase (AstocTupanue) — old fon rangini o‘z ichiga oluvchi
sohalar ustidan orga fon rangida chizish imkonini beradi;

Wet Edges (Moxkpbie Kpasi) — «ho‘l chegaralar> — mo‘ygalam
chetlarida ranglarni kuchaytirib, xuddi akvarel bilan chizish ef-
fektini beradi.

Brush (Kuctb) asbobini tanlash, yuklash va saglashni quyidagi
ketma-ketlikda ko‘rib chigamiz:

1) Brush (Kuctb) asbobini bosamiz (38-rasm).

If: Adobe Photoshop
Fle Edit Im&ge Layer Select Filter View Window

i v (DT E | reather: fopx |

o} Untitled-1 @ 66,7% (RGB)

38-rasm. Brush (Kucts) asbobini tanlash.
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2) Brush (Kuctb) paneliga kiramiz (39-rasm).

& Adobe Photoshop
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MecTran kpyTnan 1 nukc.
HecTran kpyTnan 3 nMKc.
M¥ecTran kpyTnan 5 nukc.

PO VI

MecTian kovrnan 9 nuke.

39-rasm. Brush paneli oynasi.

3) Keyin Brush (Kuctb) panelining yugori o‘ng burchagida
joylashgan strelkani bosib, mo‘ygalamlarni boshgarish menyusiga
kiramiz. U yerdan Brush Load (3arpy3uts kuctd) — mo‘yqalamlami
yuklash bandini tanlaymiz va mo‘ygalamlarni yuklaymiz (40-rasm).

& Adobe Photoshop
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P T | P e N gy P A
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a Tonsxo iera
M
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EOnBUme MIHATIOPS! I IHEHA
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13 MecTian kpyrnan 13 muxc, Ynpagnerme GubmmoTexamm. .

;9 HecTwan kpyrnas 19 mic,

40-rasm. Mo‘yqalamlarni yuklash.
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4) Photoshop dasturi yopilgandan so‘ng yuklangan mo‘yga-
lamlar ro‘yxatdan yo‘qolib ketmasligi uchun yana bir bor mo‘yqa-
lamlarni boshgarish menyusiga kirib, Brush Save (Coxpanutb
kuctn) bandini tanlab, mo‘yqalamlarni saglab qo‘yamiz (41-rasm).

3 Adobe Photoshop

aitn P : 6 Croft  Be PuneTp MpocoTp Owxvo  Cnpasxa
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a
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3ErPYIUT KIETH. ..
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SaMersrTb KMCTH. ..
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19 v|

41-rasm. Mo‘yqalamlarni saqglash.

4.2. Mo‘yqalamlarni sozlash

Mo‘yqalamni sozlash uchun Brushes palette (Ilamatpa xucteid) —
mo‘yqalamlar palitrasini parametrlar panelidagi unga mos tugmani
bosib faollashtiramiz (42-rasm).

Uchta asosiy mo‘ygalamlarni sozlash bandlarini ko‘rib chi-
gamiz (43-rasm):

1. Iunamuka dopmbl — shakl dinamikasi.

2. Paccensanue — sochilish.

3. Iunamuka npera — rang dinamikasi.

Sochilish bilan shakl dinamikasi bandlarini birga qo‘llash kerak,
aks holda sozlash samarasiz bo‘lib goladi. Shakl dinamikasi bandiga
tegishli sozlashlardan ikkitasi ko‘proq qo‘llaniladi (44-rasm):
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42-rasm. Brushes palette — mo‘yqalamlar palitrasini faollashtirish.
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44-rasm. Shakl dinamikasi bandiga oid sozlashlar oynasi.
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45-rasm. Sochilish bandiga oid sozlashlar oynasi.
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46-rasm. Rang dinamikasi bandiga oid sozlashlar oynasi.

1) JIxxurTep pasmepa — o‘lcham djitteri — mo‘ygalam o‘lcham
darajasi o‘rnatiladi, ya’ni mo‘yqalam kichkina, o‘rta, katta bo‘lishi
mumkin.

2) xuttep yraa — burchak djitteri — tegishli ravishda mo‘y-
galam burchagi o‘rnatiladi.

Sochilish bandining asosiy sozlashlari quyidagilardan iborat
(45-rasm):

1) PaccenBanune — sochilish — sochilish darajasi o‘rnatiladi;

2) Cuet — hisob — ushbu sozlash yordamida mo‘yqgalam sochi-
lish zichligi darajasi o‘rnatiladi.

Rang dinamikasi bandiga oid sozlashlarning barchasini sozlab
chigish kerak bo‘ladi (46-rasm).

9 .
Q Nazorat savollari

1. Mo‘yqgalamlarni tanlash, yuklash va saglash amallari hagida ma’lumot
bering.
2. Mo‘yqalamlarni sozlash ganday amalga oshiriladi?
3. O‘zingiz mustaqil ravishda biror mo‘ygalamning parametrlarini sozlab
chiging.
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V BOB. KONTURLARNI YARATISH VA
TAHRIRLASH. SHAKLLAR BILAN ISHLASH

5.1. Rasmlarni tahrirlash

Rasmlar, tasvirlar, fotosuratlar va h.k.larni tahrirlash uchun
Photoshop dasturining quyidagi asboblaridan foydalaniladi:

1. éj Clone Stamp Tool (Komupywommii mtamm) [S] — nusxa
oluvchi shtamp — rasmning biror gismidan piksellar nusxasini
olib, yangi joyga qo‘yish uchun ishlatiladi. Nusxalanayotgan pik-
sellar ularning ustiga kursorni keltirib, Alt tugmasini bosib turgan
holda sichqgonchani bosish orqgali tanlanadi. Yangi hosil bo‘ladigan
piksellar aynan nusxalanayotgan piksellarning o‘zidek bo‘ladi.

E Pattern Stamp (Y3opuslii mrrammn) [S] — nagsh qo‘yuvchi
shtamp — Patterns (Y3opbl) palitrasida tanlangan nagsh bilan
ko‘rsatilgan sohani to‘ldirish. Agar o‘zingiz yangi nagsh yaratmoq-
chi bo‘lsangiz, u holda quyidagilari bajarish kerak: 1) Rectangular
Marquee Tool asbobi yordamida nagsh joylashgan sohani belgi-
laymiz; 2) Edit > Define Pattern (IIpaska > Ha3mauuts y3op)
buyrug‘ini tanlaymiz va uni Patferns palitrasiga saglab qo‘yamiz.

Parametrlar paneliga quyidagi parametrlarni kiritish mumkin:

Brush (Kuctb) — galam turi va galinligini tanlash;

Mode (Pexxum) — chiziglarni rasm ustiga qo‘yilish turini tanlash;

Opacity (Henpospaunoctb) — chiziglar ko‘rinish darajasini
o‘zgartirish;

Auto Erase (Astoctupanue) — old fon rangini o‘z ichiga oluvchi
sohalar ustidan orga fon rangida chizish imkonini beradi;

Aligned (BuipaBauBanne) — nagsh chizayotganda nagsh gism-
larining bir-biriga ulanishini ta’minlovchi parametr. Agar bu para-
metr tanlangan bo‘lsa, u holda, siz gancha vaqt chizishdan to‘x-
taganingizdan gat’i nazar, chizishni davom ettirganingizda nagsh
to‘xtagan gismidan boshlab uzluksiz davom etib ketadi. Aks holda,
nagsh yana boshlang‘ich gismidan boshlab chiziladi.

2. ? History Brush Tool (ApxusHas kuctb) [Y] — avvalgi
holatga gaytish — bu asbobni tanlashdan oldin gaytish kerak bo‘lgan
holatni History (Mcropusi) yordamchi sohasida belgilashingiz kerak.
So‘ngra ushbu asbob bilan shu holatdan keyingi hamma harakat-
larni ko‘rsatilgan sohada o‘chirishingiz mumkin bo‘ladi.
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ﬁ Art History Brush Tool (ApxuBHasi XyJIoXKeCTBEHHAS KHCTD)
[Y] — avvalgi holatga badiiy gaytish — avvalgi holatga qaytish
asbobiga o‘xshash bo‘lib, farqgi oldingi holatga gaytishda turli
maxsus effektlardan foydalanish imkoniyati mavjud.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:

Brush (Kuetb) — qalam turi va qalinligini tanlash;

Mode (Pexxum) — chiziglarni rasm ustiga qo‘yilish turini tanlash;

Opacity (Henpospaunoctb) — chiziglar ko‘rinish darajasini
o‘zgartirish;

Style (Cmuuib) — maxsus effektni tanlash;

Tolerance (Iomyck) — ranglardan foydalanish, 100% da —
tasvirdagi ranglar, 0% da — ranglar ixtiyoriy olinadi;

Area ([Inametp) — asbobning ta’sir etish sohasini tanlash.

3. ’Z] Airbrush (Asporpad) [J] — puliverizatorga o‘xshash
chizish asbobi. Agar aerografdan foydalanish vaqtida Shift tugmasini
bosib sichqoncha bilan chizsak, u holda to‘g‘ri chiziglar chiziladi.
Shift tugmasi yordamida sichqonchani bosib, nuqgtalarni bir-biri
bilan bog‘lash ham mumkin.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:

Brush (Kuetb) — qalam turi va qalinligini tanlash;

Mode (Pexxum) — chiziglarni rasm ustiga qo‘yilish turini tanlash;

Pressure — bo‘yoqni sepish kuchini tanlash.

4. \QJ Blur Tool (PasmmiTne) [R] — kontrastni kamaytirish
yoki ranglarni yoyish uchun ishlatiladi.

M| Sharpen Tool (Peskocts) [R] — kontrastni ko‘paytirish
yoki ranglarni aniglashtirish asbobi.

§al | Smudge (PasvbBatens) [R] — rang yoyish yoki tortish asbobi.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin
bo‘ladi:

Brush (Kuctb) — galam (mo‘ygalam) turi va galinligini tanlash;

Mode (Pexxum) — ranglarni o‘zgartirish holatini sozlash;

Pressure (Haxum) — yoyish kuchini o‘zgartirish;

Use All Layers (CemmumpoBath Bee caon) — yoyilish hamma gat-
lamlarga yoki faqgat asosiy bo‘lgan gatlamga ta’sir etishini ta’minlaydi;

Finger Painting (PucoBanue maiblem) — rangga botirilgan
barmoq bilan chizish effektiga o‘tish.

5. E Dodge Tool (Ocsetutenn) [O] — tasvir ranglarini
ochartirish asbobi.
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@] Burn Tool (3atemuutenn) [O] — tasvir ranglarini to‘gar-
tirish asbobi.

Sponge Tool (I'yoka) [O] — biror soha ranglarining och-
to‘gligini mayin o‘zgartirish asbobi.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin
bo‘ladi:

Brush (Kuctb) — galam (mo‘yqgalam) turi va qalinligini tanlash;

Range (JImamazon) — ta’sir ko‘rsatish lozim bo‘lgan ranglar
diapazonini tanlash (Shadows — to‘q ranglar; Midtones — hamma
ranglar va Highlights — och ranglar);

Exposure (Dkeno3.) — ranglarni ochartirish kuchini o‘zgartirish;

Mode (Pexxum) — ranglarning to‘yinganligini sozlash (Desaturate
(Cau3uTh HachlmeHHOCTh) — kamaytirish yoki Safurate (IloBbicHTD
HacbllmeHHocTb) — ko‘paytirish).

Pressure (Haxxum) — asbobning ta’sir kuchini o‘zgartirish.

5.2. Image, Select va Edit menyu bo‘limlari

Tasvir ranglarini, hajmini va boshqga xususiyatlarini o‘zgartirish
uchun Image (O6pa3) menyu bo‘limiga kiruvchi buyruglardan
foydalaniladi. Bulardan eng asosiylari bilan tanishib chiqaylik:

Mode (Pexum) — holat buyrugi — tasvirni qaysi ranglarda
ifoda etish holatlarini o‘zgartirish uchun ishlatiladi, unga quyidagi
holatlar kiradi: Grayscale (I'papauum ceporo) — kulrang holatiga
o‘tkazish; Indexed Color (MnnekcupoBaHHbie nBeTa) — ko rsatilgan
ranglar holatiga o‘tkazish (256 gacha rang); CMYK Color — to‘rtta
asosiy ranglar (Cyan (C) — moviy, Magenta (M) — qizg‘ish, Yellow
(Y) — sariq, Black (K) — qora rang) orqali ifoda etish holatiga
o‘tkazish; RGB Color — uchta asosiy ranglar (Red (R) — qizil,
Green (G) — yashil, Blue (B) — ko‘k rang) orqali ifoda etish
holatiga o‘tkazish.

Adjust (Koppektuposka) — ranglarni tahrirlash — bu buy-
rugning aksariyat bandlari ranglar ustidan turli tahrirlash amallarini
bajarish uchun yordam beradi.

Avvalgi mavzularda o‘tilgan bilimlarni o‘z ichiga qgamrab oluvchi
biror mashqgning bajarilishini ko‘rib chiqalik. Faraz qilaylik, mashq
daftari uchun mugqova tayyorlash kerak. Bu mugqovaning tayyor
holati 47-rasmdagi kabi ko‘rinishda bo‘ladi.
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47-rasm. Mugovaning tayyor holdagi ko‘rinishi.

Mugova tayyorlash algoritmini ketma-ket bajaramiz:

1. Photoshop dasturini ishga tushiramiz va 500x300 piksel
o‘lchamda yangi fayl ochamiz hamda uning fonini xohlagan rangga
(bizning misolda, #6e6e6e) bo‘yab olamiz (48-rasm).

48-rasm. Yangi fayl ochish va uning foniga rang berish.
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2. Yangi gatlam (layer) ochamiz (Ctrl+Alt+Shift+N) va
Rectangular Marquee (M) asbobini tanlaymiz.

Ushbu asbob yordamida 49-rasmda ko‘rsatilgandek shakl
chizamiz va ushbu shaklni (#eeeeee) rangiga bo‘yaymiz (49-rasm).

49-rasm. Shakl chizish.

3. Belgilangan joyni o‘z holatiga gaytarish uchun Ctrl+D
tugmalarini bosamiz va ushbu gatlamni nusxalaymiz (Ctrl+J)
hamda o‘ng tomonga olib o‘tamiz (50-rasm).

50-rasm. Shaklni nusxalab, ong tomonga olib o‘tish.
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4. So‘ngra mugovaning betlarini bir-biriga bog‘laydigan uch
olchamli shakl tayyorlaymiz. Buning uchun joriy gatlamni Select >
Load Selection buyrug‘ini tanlash orgali belgilaymiz.

Yangi qatlam ochamiz (Ctrl+Alt+Shift+N), Gradient (G)
asbobini tanlab, ranglarni qoradan shaffofga moslaymiz va chap
tomondan o‘ngga garab gradiyent chizamiz (51-rasm).

51-rasm. Gradiyent chizish.

Belgilangan joyni oz holatiga gaytarish uchun Ctrl+D tugma-
larini bosamiz va Ctrl+J tugmalarini bosish orqali ushbu gatlamni
nusxalaymiz hamda gatlam hajmini kichraytiramiz (52-rasm).

52-rasm. Qatlam hajmini kichraytirish.
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5. Ushbu gatlamni pastdagi gatlam bilan birlashtirish uchun
Ctrl+E tugmalarini bosamiz. Endi esa ushbu gatlamni nusxalaymiz
(Ctrl+J) va bu gatlamni gorizontal o‘girish uchun Edit >
Transform > Flip Horizontal buyrug‘ini tanlaymiz va hosil bo‘lgan
gatlamni mugovamizning chap tomoniga akslantiramiz (53-rasm).

53-rasm. Qatlamni chap tomonga gorizontal akslantirish.

6. Endi ushbu gora shakl yoniga oq shakl chizib olishimiz
kerak. Buning uchun yangi gatlam ochamiz (Ctrl+Alt+Shift+N),
Rectangular Marquee (M) asbobi yordamida 54-rasmdagi kabi
shakl chizib, so‘ngra Gradient (G) asbobini tanlab, ranglarni og-
dan shaffofga moslab, shaklimizning chap tomonidan o‘ng to-
monga garab gradiyent chizamiz (54-rasm).

54-rasm. Gradiyent chizish.
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7. Belgalangan joyni o‘z holatiga qaytarish uchun Ctrl+D
tugmalarini bosamiz va belgilangan sohaga Flter > Blur > Motion
Blur buyrug‘ini qo‘llaymiz (55-rasm).

Motion Bur e
H : @
e .
[
o
.

55-rasm. Filter > Blur > Motion Blur buyrug‘i oynasi.

8. Yugoridagi bosgichni mugovamizning chap gismiga ham
go‘llaymiz (56-rasm).

56-rasm.
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9. Ushbu bogichda ikkita mugovani bir-biriga bog‘lab chigamiz.
Line (U) asbobni tanlaymiz (Weight: 3 px) va 57-rasmda ko‘r-
satilgan joyga oq rangli shakl chizamiz (57-rasm).

57-rasm. Shakl chizish.

Ushbu gatlamni tanlaymiz va Layer > Rasterize > Shape va
Select > Load Selection buyruglarini bajaramiz.

10. Yangi gqatlam ochamiz (Ctrl+Alt+Shift+N), bu gatlamni
«sim1» deb nomlab olamiz. Gradient (G) asbobini tanlab, ranglarni
goradan shaffofga moslab, shaklning qog‘ozga birlashadigan joy-
lariga gradivent chizamiz (58-rasm).

58-rasm. Shaklning qog‘ozga birlashadigan joylariga gradiyent chizish.
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11. Belgilangan joyni o‘z holatiga qaytarish uchun Ctrl+D
tugmalarini bosamiz va Edit > Free Transform buyrug‘ini tanlab,
shaklni ozgina o‘ng tomonga giyalatamiz (59-rasm).

59-rasm. Shaklni o‘ng tomonga giyalatish.

12. Shaklga quyidagi effektlarni ketma-ket qo‘llaymiz:
Layer > Layer style > Inner Shadow cffektini quyidagi para-
metrlar bilan go‘llaymiz (60-rasm):

Layer Style 3
Styles — Inner Shadow KT‘
[~ Structure
o B — |
[JDrop Shadow .
o RewSye
o e e (C) BT e s Bleveicn
Clinner Gow Distance: fm—=—— [} |px
[CJBevel and Emboss Coke: === o |% .
[Jcontour Size: f————mx Ew
[ Texcture -
[I5atin — Quality
[ Color Ovarlay Contour: I]j [ Anti-aliased
[ Gradient Overtay Moisa:
e %
CPattern Overlay [C]
[CIstroke

60-rasm. Layer > Layer style > Inner Shadow oynasi.
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Outer Glow effektini quyidagi parametrlar bilan gqo‘llaymiz
(61-rasm):

Layer Style [x
proves — Outer Glow o]
By Ot Do B e —
[orep Shadaw Opacity: E=pp—=—x (20|
[Finner Shadow 4 : New Style.

m:@ : - .

)Preview

Clivarei? OH O ]
[ClBevel and Emboss . .
Dlcontour Tacheique: [Softer (]
[ Texture Spread; ——— Dx
[satin Sae: m——— || |px
[ <olor Overlay
] Gradient Overlay Sty
[IPattern Overtay m:m [ anti-skased
Clotes R . El
Stter: ——— [p|%

61-rasm. Layer > Layer style > Outer Glow oynasi.

Shundan keyin bizda quyidagicha natija hosil bo‘ladi (62-rasm):

62-rasm. Shaklga effektlar qo‘llagandan keyingi natija.
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13. Endi sim mugovaning ikkala betini birlashtirib turishi uchun
qgog‘ozlarda u kirib turadigan teshiklarni tayyorlaymiz Buning
uchun «iml» gatlamining ostidan yangi gatlam ochamiz (Ctrl+
Alt+Shift+N) va Elliptical Marquee (M) asbobi yordamida quyi-
dagicha shakl chizib, uni gora rangga bo‘yab olamiz (63-rasm).

63-rasm. Qog‘ozlar uchun teshik tayyorlash.

14. Belgilangan joyni o‘z holatiga gaytarish uchun Ctrl+D tug-
malarini bosamiz va ushbu gatlamni nusxalaymiz (Ctrl+J) hamda
mugovaning o‘ng tomoniga olib o‘tamiz (64-rasm).

64-rasm. Teshikni nusxalab, o‘ng tomonga qo‘yish.
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15. Endi simli gatlam va ikkita qora aylana chizilgan gatlamlarni
birlashtiramiz (Ctrl+E) va ushbu gatlamni bir necha bor nusxalab
(Ctrl+J)), quyidagicha ketma-ketlikda qo‘yib chigamiz (65-rasm).

65-rasm.

16. Simli gatlamlarni birlashtirib chigamiz (Ctrl+E) va hosil
bo‘lgan gatlamga Layer > Layer style > Drop shadow eftektini
go‘llaymiz (66-rasm):

Layer Style E
— Drop Shadow | . |
— Structure
LTS e r— |
Opacity: E=—gg——— [30_]% New Style...
w@ [Juse Globai Light [Preview

Distance: f———— E'w:
Spread: ———x D“ .
Siee: p— Elpm
— Quality -
Contour: [ snti-atased
Noise: f—c———m) 9‘
[#]Layer Knocks Out Brop Shadow

66-rasm. Layer > Layer style > Drop shadow oynasi.
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17. Ushbu gatlam ustiga sichqonchaning o‘ng tugmasini bosib,
Create Layer buyrug‘ini tanlaymiz (67-rasm).

Inner Glow...

Bevel and Emboss...
Satin...

Color Overlay...
Gradient Overlay... =
Pattern Overlay... |
Stroke... kv

Copy Layer Style
Paste Layer Style
Clear Layer Style

67-rasm. Create Layer buyrug‘ini tanlash.

Ko‘rib turganingizdek, yana bitta gatlam paydo bo‘ldi (68-
rasm). Ushbu gatlam ostida turgan qatlamni tanlaymiz.
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68-rasm. Yangi gatlam ko‘rinishi.

Eraser (E) asbobini tanlaymiz, 13 px li yumshoq mo‘yqalamni
tanlab, yon tomondagi soyalarni o‘chirib chigamiz.
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18. Nihoyat oxirigi bosgichni bajaramiz. Simli gatlamni tanlab,
Create Layer (Ctrl+J) buyrug‘i orgali uni nusxalaymiz. Bu gat-
lamga Edit > Transform > Flip Horizontal buyrug'ini qo‘llab,
Move (V) asbobi yordamida ozgina yugoriga ko‘taramiz.

Ushbu nusxalangan gatlamni barcha gatlamlar ostiga olib
o‘tamiz, ya'ni gatlamlar palitrasida orqa fon (background) pikto-
grammasining yugqorisiga ushbu gatlam piktorammasini qo‘yamiz.

Endi Layer > Layer style > Color Overlay buyrug‘ini bajaramiz
(69-rasm).

Layer Style x

Styles Color Overlay E
= Color -

Biending Options: Default | Bland Mode: [Normal 7] [N
[Jorop Shadow Opacty: E=f——— 20 |¥
[Cinner Shadow | -
O Cuter Glow [#IPreview
[Cianer Glow
[[]Bavel and Emboss .

[ Contour

[ Texture
[Csatn |
T

[ Gradient Overtay
[CIPsttern Overtay
[stroke

69-rasm. Layer > Layer style > Color Overlay oynasi.

Nihoyat mashqgimiz tugadi. Ushbu muqovaga matn yozishimiz
ham mumkin. Natija 70-rasmdagi kabi ko‘rinishda bo‘ladi. Shuni
aytish mumkinki, ushbu yo‘l bilan siz nafagat muqova, balki buk-
letlar ham yasashingiz va uni yaqinlaringizga sovg‘a qilishingiz
mumkin.

Hozirgi kunda sodda va murakkab rastrli grafikani tahrirlash
dasturlarining soni juda ko‘pdir. Shunday dasturlardan biri —
Windows operatsion tizimi tarkibiga kiruvchi Paint dasturidir.
Mazkur dastur oddiy amallarni bajarish imkoniyatini beradi, lekin
professional darajadagi imkoniyatlardan foydalanish uchun maxsus
rastrli grafik dasturlaridan foydalanish kerak bo‘ladi.
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70-rasm. Mugovaning natijaviy ko‘rinishi.

Adobe Photoshop dasturi hozirgi kunda eng mashhur va butun
dunyo mutaxassislari tomonidan tan olingan grafik dastur hisob-
lanadi. Bunga asosiy sabablar — tasvir bilan ishlashdagi keng im-
koniyatlarning mavjudligi, qulay va oson interfeys, deyarli barcha
grafik formatlar va tizimlar bilan ishlay olishi.

Adobe Photoshop dasturining oxirgi versiyalari Adobe
Photoshop CS, Adobe Photoshop CS5 bo‘lib, ular rastrli grafika
bilan ishlovchi deyarli barcha zamonaviy texnologiyalarni gamrab
olgan.

5.3. Shakllar bilan ishlash

Photoshop dasturida oddiy shakllarni chizish quyidagi asboblar
orgali amalga oshiriladi:

1. O] Rectangle (Ipsmoyromsmuk) [U] — to‘rtburchak —
to‘rtburchak chizish.

El Rounded Rectangle (Cxpyraennblii npaMoyroibnuk) [U] —
aylanasimon to‘rtburchak — aylanasimon to‘rtburchak chizish.
Bu asbob tanlanganda Parametrlar panelida chigadigan Radius
maydonida burchaklar radiusini kiritish mumkin.

E Ellipse (Damanc) [U] — aylana — aylana, oval chizish.
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_6| | Polygon (Mnoroyromsauk) [U] — ko‘pburchak — ko‘p-
burchak chizish. Bu asbob tanlanganda Parametrlar panelida chi-
gadigan Sides (Ctoponbn) maydonida ko‘pburchak tomonlarining
sonini ko‘rsatish mumkin.

LJ Line (JInnug) [U] — chiziq — to‘g‘ri chiziq chizish. Chiziq
galinligini Weight (Toammua) maydonida ko‘rsatish mumkin.

i] Custom Shape (Ilpowssoabnas dwurypa) [U] — maxsus

shakllar, turli tayyor shakllar chizish. Parametrlar panelida chiga-
digan Shape (®Purypa) maydonida kerakli shaklni tanlash mumkin.

Har qaysi shakl chizish asbobi uchun parametrlar panelida
quyidagi parametrlarni kiritish mumkin:

shakl chizilish holatini o‘zgartirish tugmalari (Create New
Shape Layer — shakl yangi gatlamda chiziladi; Create New Work
Path — shaklning konturi bo‘yicha yangi yo‘llar paydo bo‘ladi;
Filled Region — shakl joriy gatlamda chiziladi);

shakl chizish yo‘llari (Unconstrained — ixtiyoriy; Square —
teng tomonli; Fixed Size — o‘rnatilgan o‘lchamli; Proportional —
proporsional).

Layer Style (Ctunp) — rang bilan bo‘yash turi.

2. i} Pen Tool (Ilepo) [P] — pero — sichqgoncha yordamida
nuqtalar orqgali shakl yaratish imkonini beradi.

J Freeform Pen (IIpoussoibhoe nepo) [P] — ixtiyoriy pero —

s1chqonchan1 bosib turgan holda ixtiyoriy harakatlar bilan shakl
yaratiladi.

@t' Add Anchor Point (Jlo0BATH TOYKY) — yangi nuqta qo‘-
shish — sichqoncha yordamida shaklga yangi burilish nugtasi qo‘shiladi.

| Delete Anchor Point (Ypamats Touky) — nugtani o‘chirish —
sichqoncha yordamida shakldagi burilish nugqtasi o‘chiriladi.

ﬂ Convert Point (1IpeoGpa3oBath TOYKY) — nugtani o‘zgar-
tirish — shakl nugqtalarining joylashishini o‘zgartirish (cho‘zish).

3. Notes (3ametku) [N] — izoh (eslatma) qo‘shish — rasm-
ning ixtiyoriy sohasiga matnli izoh qo‘shish.

j Audio Annotation (3BykoBoe omucanme) [N] — ovozli

izohlar — rasmning ixtiyoriy sohasiga mikrofon orqali ovozli izoh
go‘shish. Paydo bo‘lgan oynada Start tugmasini bosib ovoz yozishni
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boshlaymiz, yozishni to‘xtatish uchun Sfep tugmasini bosamiz.
Ovoz yozish oynasidan chiqgib ketish uchun Cancel tugmasini

bosamiz.

‘) 3
Q Nazorat savollari

1. Qalam, mo‘yqgalam va shtamp asboblarining bajaradigan vazifalarini
aytib bering.

2. Dasturda o‘chirg‘ichning ganday xillari mavjud?

3. Gradiyent bo‘yash va ajratilgan sohani biror rang bilan bo‘yash
asboblarining farqini tushuntiring.

4. Tasvirga matn gaysi asbob yordamida qo‘shiladi?

5. Shakl yaratish asboblarining xillarini sanab o‘ting va ularga izoh
bering.
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VI BOB. RANG BILAN ISHLASH

6.1. Yetti xil asosiy nurlarning kelib chigishi

Rastrli kompyuter grafikasida ranglar modeliga katta e’tibor
garatish kerak. Grafikada, asosan, 2 xil rang modeli ishlatiladi:
RGB (red, green, blue) va CMYK (Cyan, Magenta, Yellow, blacK).
RGB rang modeli, asosan, monitorlarda tasvirni ko‘rsatish uchun,
CMYK rang modeli esa bosmada ishlatiladi.

Rang — bu bizning yorug'lik nurini sezishimizning omillari-
dan biridir. Olimlar azaldan nur va rang bilan qiziqib kelganlar.
Bu sohadagi birinchi olamshumul yutuglardan biri Isaak Nyuton-
ning oq yorug‘lik nurini tashkil etuvchilarga ajratish bo‘yicha 1666-
yilda o‘tkazgan tajribalaridir. Bungacha oq nur eng sodda nur
degan tasavvur mavjud edi. Nyuton buni inkor etdi.

Nyuton tajribalarining mohiyati quyidagicha: oq yorug‘lik nuri
(quyosh nuridan foydalanildi) uchburchakli shisha prizmaga yo°‘-
naltiriladi. Prizmadan o‘tgan nur sinib, ekranga yo‘naltirilganda
ranglar sohasi — spektrni hosil giladi. Spektrda asta-sekinlik bilan
biridan ikkinchisiga o‘tuvchi kamalakning barcha ranglari mavjud
edi. Bu ranglar boshqa gismlarga ajralmaydi. Nyuton spektrni
yaqqol ko‘rinadigan turli ranglarga mos keluvchi yetti gismga aj-
ratdi. U ushbu yetti rangni, ya’ni qizil, zarg‘aldoq, sariq, yashil,
havorang, ko‘k va binafsha ranglarni asosiy ranglar deb hisoblardi.
Ba’zilar buni Nyutonning yetti sonining sirli xususiyatiga ishon-
ganligi bilan tushuntiradilar.

Tajribalarning ikkinchi qismi quyidagicha o‘tkazildi: bir priz-
madan o‘tgan nurlar ikkinchi prizmaga yo‘naltirildi va u orqali
yana oq nur olishga erishildi. Shunday qilib, oq rang ko‘plab
boshga ranglarning qorishmasidan iborat ekanligi isbotlandi. Yetti
asosiy rangni Nyuton halga bo‘ylab joylashtirdi (71-rasm).

Nyuton biror rang ma’lum nisbatda olingan asosiy ranglarni
aralashtirish natijasida hosil bo‘ladi, deb faraz qildi.

Spektri birgina to‘lgin uzunligiga mos kelgan bitta chizigdan
iborat bo‘lgan nurlanish monoxromatik nurlanish deyiladi. Nyuton
tomonidan olingan kamalak (shuningdek, yomg‘irdan keyin kuza-
tiladigan kamalak ham) cheksiz ko‘p monoxromatik nurlanish-
lardan tashkil topgandir. Lazer monoxromatik nurlanishning ancha
sifatli manbayi hisoblanadi.
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Qizil Zarg‘aldoq

Binafsha rang Sariq

Ko‘k Yashil

Havorang

71-rasm. Yetti asosiy rang halgasi.

Monoxromatik nurlanishning rangi to‘lgin uzunligi bilan anig-
lanadi. Ko‘zga ko‘rinadigan nurlar uchun to‘lgin uzunliklari dia-
pazoni 380—400 nm (binafsha)dan to 700—780 nm (qizil)gacha
oraligda bo‘ladi. Bu diapazonda inson ko‘zining sezuvchanligi bir
xil emas. Eng yuqori sezuvchanlik yashil rangga to‘g‘ri keluvchi
to‘lgin uvzunliklarida kuzatiladi.

Rangni tavsiflash uchun quyidagi belgilardan foydalaniladi:

— rang tusi (toni), uni nurlanish spektrida ustunlik giluvchi
to‘lgin uzunligi bilan aniglash mumkin. Rangning tusi bir rangni
boshgasidan ajratish imkonini beradi, masalan, yashilni gizildan,
sarigdan yoki boshga ranglardan;

— yorgqinlik, yorug‘lik nurining energiyasi, intensivligi bilan
aniglanadi. Qabul qilinayotgan yorug‘lik nurining miqgdorini
ifodalaydi;

— to‘yinganlik yoki tusning tinigligi, oq rangning mavjudligining
ulushi bilan ifoda etiladi. Ideal sof rangda oq rang aralashmasi
bo‘lmaydi. Masalan, sof qizil rangga ma’lum nisbatda oq rang
go‘shilsa, och qizil rang hosil bo‘ladi.

Aytib o‘tilgan ushbu uch belgi barcha ranglar va ularning yor-
qinliklari (ottenkalari)ni ifodalashga imkon beradi. Belgilarning
uchta ekanligi rangning uch o‘lchamlilik xususiyatiga egaligidan
darak beradi.
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6.2. RGB rang modeli

RGB rang modelidan nurlanish prinsipi asosida ishlovchi quril-
malar yordamida olinadigan ranglarni ifodalash uchun foydalaniladi.
Asosiy ranglar sifatida qizil (Red), yashil (Green) va ko‘k (Blue)
olingan.

RGB modelining gisqacha tarixi shunday: Tomas Yung (1773—
1829) uch dona fonar oladi va ularga qizil, yashil hamda ko‘k
yorug‘lik filtrlarini o‘rnatadi. Shu tarzda ushbu ranglarga mos
keluvchi nur manbalari olindi. Olim oq ekranga bu uch manbadan
chiggan nurlarni yo‘naltirib, mana shunday tasvirni oldi (72-rasm).
Ekranda manbalardan chiggan nurlar rangli doiralar shaklini hosil
qildi. Doiralarning kesishish joylarida ranglarning qo‘shilishi kuza-
tildi. Sariq rang qizil va yashil ranglarning qo‘shilishidan, gizg‘ish
rang qizil va ko‘k ranglarning qo‘shilishidan, havorang ko‘k va
yashil ranglarning qo‘shilishidan, oq rang esa uchta asosiy rangning
go‘shilishidan hosil bo‘ladi.

Boshga ranglar va uning nozik turlari yuqorida aytilgan asosiy
ranglarni bir-biriga ma’lum miqgdorda qo‘shilishi bilan olinadi.

Qizl

Qizg‘ish

Ko‘k Yashil

Oq Havorang

72-rasm. RGB modelining asosiy ranglari va ularning qo‘shilishidan
hosil bo‘lgan go‘shimcha ranglar.
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Hozirgi paytda RGB modeli rasmiy standart bo‘lib hisoblanadi.
Yoritish bo‘yicha Xalgaro komissiyaning — YXK (CIE —
Comission International de Eclairage) garoriga ko‘ra, 1931-yilda
asosiy ranglar standartlashtirilib, ulardan R, G va B sifatida foy-
dalanish tavsiya etildi. Bular yorug‘lik nurlanishining quyidagi
to‘lgin uzunliklariga mos keluvchi R — 700 nm; G — 546,1 nm,
B — 435,8 nm monoxromatik ranglardir: qizil rang filtr o‘rnatilgan
cho‘g‘lanma lampa yordamida olinadi. Sof yashil va ko‘k rang-
larni olish uchun simobli lampa qo‘llaniladi. Shuningdek, har bir
asosiy rang uchun yorug‘lik ogimining qiymati ham standartlash-
tirilgan.

RGB tizimi uchun yana bir muhim parametr — bir xil miqdorda
olingan uch xil rangning aralashuvidan hosil bo‘ladigan oq rangdir.

RGB tizimi hozirgi vaqtda, birinchi navbatda, rangli televizorlar
va kompyuterlarning displeylarida keng qo‘llanilmogda. Ranglarning
ba’zi yorqinliklarining yetishmasligi uncha ham sezilmaydi.

RGB tizimining ommabopligini ta’minlovchi yana bir omil
uning vaqqol ko‘rinishidir: asosiy ranglar ko‘rish spektrining yaqqol
farglanadigan gismlarida joylashgandir.

Bundan tashgari, insonning rangli ko‘rishini tushuntiruvchi
gipotezalardan biri — uch tashkil etuvchili nazariya odamning ko‘-
rish tizimida uch turdagi yorug‘likni sezuvchi elementlar borili-
gini ta’kidlaydi. Bir tur elementlar yashil rangni, boshqa turi qgizil
rangni, uchinchi turi esa ko‘k rangni sezadi. Bunday gipotezani
Lomonosov aytib o‘tgan, uni asoslash bilan T. Yungdan boshlab
ko‘plab olimlar mashg‘ul bo‘ldilar. Uch tashkil etuvchili nazariya
odamning rangli ko‘rishining yagona nazariyasi emas.

RGB-palitra — tabiatdagi barcha ranglar uch asosiy rang: Red —
qizil, Green — yashil, Blue — ko‘k ranglarning aralashmasidan
yuzaga keladi. Bu ranglarning qo‘shilish miqdorlariga garab turli
rang yorqginliklari kelib chigadi. RGB-palitradagi ranglar juda yorqgin
va ko‘zga tashlanuvchan bo‘lgani sababli, ulardan Internet sahi-
falarini bezashda foydalanish qulaydir.

6.3. CMYK rang modeli

CMY rang modeli ranglarning yutilish (ayirish) prinsipi amalga
oshiriladigan qurilmalarda tasvirni hosil gilishda rangni ifodalash
uchun go‘llaniladi. Bu prinsip, birinchi navbatda, qog‘ozga bosuv-
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Qirmizi

Qizl

Sariq Havorang

Qora Yashil

73-rasm. CMY modelining asosiy ranglari va ularning qo‘shilishidan
hosil bo‘lgan go‘shimcha ranglar.

chi qurilmalarda go‘llaniladi. Ushbu modelning atalishi asosiy
subtraktiv ranglar — havorang (Cyan), girmizi (Magenta) va sariq
(Yellow) ranglarning nomlanishidan tuzilgan (73-rasm).

Oq qgog‘ozga sariq bo‘yoqning surtilishi gaytgan ko‘k rang
yutilishini bildiradi. Havorang bo‘yoq qizil rangni, girmizi bo‘yoq
yashil rangni yutadi. Bo‘yoglar kombinatsiyasi gqolgan yashil, qizil,
ko‘k va gora ranglarning olinishini ta’minlaydi. Qora rang barcha
ranglarning gaytishdagi yutilishini bildiradi.

Amaliyotda ranglarning idealmasligi sababli ularning aralash-
masidan qora rangni olish qiyin, shuning uchun bosma qurilma-
larida yana qora rang (blacK) ham ishlatiladi. Unda bu model
CMYK modeli deb ataladi.

Shuni ta’kidlash lozimki, har ganday bo‘yoq ham yuqorida
ko‘rsatilgan CMY ranglarining yutilishini ta’minlayvermaydi.

1-jadvalda RGB va CMY modellaridagi ba’zi ranglar hagida
ma’lumot keltirilgan.

Bu yerda tashkil etuvchilar 0 dan 1 gacha bo‘lgan diapazondagi
sonlar bilan kodlanadi, deb hisoblanadi. Sonlarning boshga diapa-
zoni uchun ularga mos keluvchi nisbatlarni yozish mumkin.

Hozirgi kundagi rangli printerlar CMYK-palitradagi ranglar
(C — cyan, M — magenta, Y — yellow, K — blacK, Blue — ko‘k
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1-jadval

Rang RGB modeli CMY modeli

R G B C M Y
Qizil 1 0 0 0 1 1
Sariq 1 1 0 0 0 1
Yashil 0 1 0 1 0 1
Havorang 0 1 1 1 0 0
Kok 0 0 1 1 1 0
Qirmizi 1 0 1 0 1 0
Qora 0 0 0 1 1 1
Oq 1 1 1 0 0 0

bilan adashtirmaslik uchun oxirgi harfi olingan) bilan ishlaydi.
Printerlarda qog‘ozga rang tushirish quyidagi tartibda amalga oshi-
riladi:

Qog‘oz

I |
Rang berish
lotogi

CMYK tizimidagi ranglar nisbatan xira, ammo tabiiyga yaqin
bo‘lganligi uchun undan ko‘pincha tayyor rasmlar bilan ishlashda
foydalaniladi. Agar tasvir RGB modelida ishlangan bo‘lsa, chop
etishdan oldin printer uni avtomatik tarzda CMYK ranglarga ajra-
tadi, natijada chiggan tasvir ekrandagidan farq qilishi mumkin.

6.4. Ranglarning boshqa modellari

RGB modelida mavjud bo‘lgan manfiy koeffitsiyentlar muam-
mosini hal etish uchun Yoritish bo‘yicha Xalgaro komissiya (CIE)
tomonidan XYZ kolorimetriva tizimi qabul qilindi. YXK XYZ
tizimida ham asosiy ranglar sifatida uch rang gabul qilindi, ammo
bular shartli, real bo‘lmagan ranglardir.
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Yashil

Saturation

Qora

74-rasm. HSV modelining tasvirlanishi.

Yugorida ko‘rib chigilgan rang modellari u yoki bu tarzda ba’zi
asosiy ranglarning qo‘shilishidan foydalanadi. Endi esa ulardan
o‘zgacha, alternativ rang modelini ko‘rib chigamiz.

HSYV modelida rang tus (ton) H (Hue), to‘yinganlik S (Satu-
ration), yorginlik V (Value) kabi parametrlar bilan ifodalanadi.
H ning giymati 0 dan 360 gacha bo‘lgan graduslarda o‘lchanadi,
chunki bu yerda kamalak ranglari aylana bo‘yicha quyidagi tartibda
joylashtiriladi: qizil, zarg‘aldoq, sariq, yashil, havorang, ko‘k,
binafsha. S va V ning giymati 0—1 oraligda joylashadi.

HSYV model uchun ranglarning kodlanishiga misol keltiramiz.
S=0 giymat (ya’ni V o‘qgida) kulrang tuslarga, V=0 giymat esa
gora rangga to‘g‘ri keladi. Aylana bo‘yicha bir-birining garshisida
joylashgan, ya’ni bir-biridan H bo‘yicha 180° ga farq giluvchi
ranglar qo‘shimcha ranglardir. Rangni HSV parametrlari orqali
tasvirlashga topshiriglar grafik tizimlarda tez-tez uchrab turadi.
Bu model odatda ochilgan konus shaklida ko‘rsatiladi (74-rasm).

HSYV ga o‘xshash qurilgan boshqa rang modellari ham mavjud,
masalan, HLS (Hue, Lighting, Saturation) modeli ham rang konu-
sidan foydalanadi.

Modellarning turli-tumanligi ulardan turli sohalarda foydalanish
bilan bog‘lig. Rang modellaridan har biri tasvirni kiritish, uni ek-
randa ko‘rinadigan holatga keltirish (vizualizatsiya), qog‘ozga chop
etish, tasvir ustida ishlash, fayllarda saglash, kolorimetrik hisob-
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kitoblar va o‘lchovlar kabi ayrim operatsiyalarni samaraliroq baja-
rish uchun ishlab chigilgan. Bir modelning boshqgasiga almashti-
rilishi tasvirdagi ranglarning buzilishiga olib kelishi mumkin.

Rastr tasvirlar quyidagi tiplarga bo‘linadi: binar, kulrang, palit-
rali, to‘liq kulrang. Bunda tasvirning elementlari fagat ikki giymatni
(0 yoki 1) gabul gilishi mumkin. Bu tasvirlar turlicha paydo bo‘lishi
mumkin. Ular ko‘p hollarda kulrang, palitrali va turli rangli tas-
virlarni o‘zgarmas yoki adektiv chegaraviy son bilan binar tasvirga
almashtirish natijasida paydo bo‘ladi. Binar tasvirlarni saglash
uchun juda katta joy talab gilinadi. Ularning har bir elementi
uchun 1 bit joy kerak bo‘ladi. Kulrang tasvirning elementlari ma’-
lum bir rang intensivligining turli xil giymatlarini gabul qiladi.
Odatda, bu tasvirlarning har bir elementini saglash uchun § bit
ishlatiladi. Kulrang tasvirlar turli xil amaliy masalalarini hal gilishda
eng ko‘p qo‘llaniladigan tasvirlardan biri hisoblanadi.

Palitrali tasvirlarning har bir elementiga ranglar palitrasining
bir yacheykasidagi rang mos qo‘yiladi. Palitra — bu ikki o‘lchovli
massiv bo‘lib, uning satrlariga turli ranglar, har bir ustunlariga
esa ma’lum bir rangning intensivligi joylashtiriladi.

To‘liq rangli tasvirlar elementlari rangni tashkil etuvchi yor-
qinliklar haqgidagi axborotni o‘zida saglaydi. Shu bilan u palitrali
tasvirlardan farq giladi.

Amaliy masalalar yechishda qaysi turdagi tasvirni tanlash masa-
laning o‘ziga xos xususiyatlaridan kelib chiqib, tasvirdagi zarur
axborotni ganchalik to‘liq ifodalanishi bilan xarakterlanadi. Bundan
tashqari, to‘liq rangli tasvirlardan foydalanish katta hajmdagi hisob-
lash resurslarini talab gilishini e’tiborga olish kerak.

Rastrli grafika bilan ishlash dasturlari bir nechta vazifalarni
bajarish imkonini beradi:

— tasvirni import qilish — tasvirni skaner, ragamli fotoappa-
ratdan kiritish, boshga formatdagi rasmlarni kiritish (bmp, jpg,
png, tif, gif, psd, pdf, wmf va boshq.);

— tasvirni tahrirlash — tasvirga o‘zgartirishlar kiritish, ranglar bilan
bo‘yash, chizish, o‘chirish, yorqinlik va aniqlik darajasini o‘zgartirish;

— rang tizimini o‘zgartirish;

— chop etish;

— boshga nom va format bilan saqlash;

— turli effektlarni qo‘llash.
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6.5. Palitralar bilan ishlash

Photoshop dasturidagi ko‘p amallar siljitiladigan palitralar yor-
damida bajariladi. Ekranda palitralar ko‘p joy egallamasligi uchun,
palitralar quyidagi guruhlarga biriktirilgan: Navigator/Info (Hasu-
ranusa/Mnadopmanna) — Navigatsiya/Ma’lumot, Color/Swatches/
Styles (Ilet/O6pa3upl/Crromm) — Rang/Ko‘rsatmalar/Stillar,
History/Actions/Tool Presets (Mctopnsa/deiicteusi/Ha6op
aHcTpymMentoB) — Tarix/Amallar/Asboblar majmuasi, Layers/
Channels/ Paths (Cnon/Kananasl/Kontypsr) — Qatlamlar/Kanallar/
Konturlar va Character/ Paragraph (Wlpudt/A63an) — Shrift/Abzas.

Xohlagan palitrani ochish uchun asosiy menyuning Window
(OxkHo) bo‘limi buyruglaridan foydalanamiz. Ko‘rsatilgan palitra
shu guruhga kiradigan boshga palitralar ustiga joylashtiriladi.

Ba’zi palitralarni biror asbobni tanlaganda Parametrlar pane-
lida paydo bo‘ladigan shu asbobga tegishli bo‘lgan palitrani ochish
tugmasi yordamida, masalan, Type (Tekct) asbobidan Character/
Paragraph palitrasini ochish mumkin. Tab tugmasini bosish orgali
barcha ochiq palitralarni, asboblar panelini ko‘rinadigan/ko‘rin-
maydigan hollarga keltirish mumkin. Shift+Tab tugmalari bosilsa,
asboblar panelidan tashqari ochiq turgan palitralarni ko‘rinadigan/
ko‘rinmas hollarga keltirish mumkin.

Agarda biror palitralar guruhidagi qandaydir palitrani faollash-
tirish kerak bo‘lsa, o‘sha palitra nomiga sichqoncha yordamida
bosish kifoya qiladi. Palitrani guruhdan ajratib olish imkoniyati
ham bor, buning uchun palitra nomidan ushlab uni tashqariga
olib chiqgish kerak (75-rasm). Agarda guruhga palitra qo‘shmoqchi
bo‘lsangiz, palitra nomidan ushlab turib uni shu guruhga tashlash
kerak bo‘ladi (76-rasm), shu yo‘l bilan birga guruhga boshqga
guruhni ham qo‘shsa bo‘ladi. Sichgoncha yordamida palitra o‘l-
chamlarini o‘zgartirish (kattalashtirish yoki kichiklashtirish) mum-
kin, buning uchun uning o‘ng pastki burchagidan tortish (tashqariga
yoki ichkariga) kerak bo‘ladi.

Palitrani yig‘'mogqchi/yoymoqchi (cBepHYTB/pa3BepHYTH) bo‘l-
sangiz, palitra nomiga ikki marta sichgoncha bilan bosing yoki oyna-
ni o°‘ng yuqori gismidagi mos yig‘ish/yoyish tugmachalarini bosing.

Palitra o‘lchami dasturda oldindan o‘rnatilgan (mo ymorgaHmio)
holdagisidan boshgacha bo‘lsa, Minimize tugmasiga sichqoncha
bilan bosib, palitra o‘lchamini dasturda oldindan o‘rnatilgan
holdagiga gaytarish mumkin.
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76-rasm. Palitralar guruhga palitrani go‘shish.

Agarda Edit > Preferences > General (IIpaska > YcTanoku >
Oomme) mulogot oynasidagi Save Palette Locations (CoxpaHuTh
pacnoJioxkenue naautp) maydoniga bayrogqcha qo‘yilgan bo‘lsa,
Phetoshop dasturidan chiqib ketishdan oldin palitralar ganday joylash-
gan bo‘lsa, dasturga gaytadan kirganda shu holda ekranga chigariladi.

Palitralar guruhlarini dasturda oldindan o‘rnatilgan holdagi
joylashuvini gayta tiklash uchun Window > Workspace > Reset
Palette Locations (Oxno > Pagouee none > BoccranaButh pacno-
Jokenne maautp) buyrug‘idan foydalanish lozim.

Swatches palitrasi

Swatches (O6pa3npl) palitrasida (77-rasm) tayyor ranglarning
namunalari keltiriladi. Swatches palitrasini ranglar palitrasiga
go‘shgan yoki alohida holda ishlatish mumkin. Palitraning menyusi
buyruglari orgali ranglar namunalarini yuklash yoki xotiraga saqglab
go‘yish mumkin.
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New Swaltch

v Small Thumbnad
Smal List

Presst Manager.

Rezet §
Load Swalches..
Save Swalches..
Replace Swalches..

ANPA Colors

DIC Color Guide
FOCOLTONE Colors

HKS E

HES K

HKS N

HESZ

Mac 05

PANTONE metalic coated
PANTONE pastel costed
PANTONE pastel uncoated
PANTONE process coated
PANTONE solid coated
PANTONE sofid matte
PANTONE solid to process
PANTONE solid uncoated
TOYO Colors

77-rasm. Swatches palitrasi va menyusi.

Kiritish/chiqarish qurilmalari, kompyuter dasturlari ranglarni
turli ko‘rinishda qayta ishlaydi, shuning uchun ranglar bilan
ishlashda ko‘plab muammolar yuzaga kelishi mumkin. Masalan,
biror grafik obektni turli dasturlarda, masalan, tasvirlarni gayta
ishlash dasturlarida yoki Web-brauzerlarda ko‘rganimizda undagi
ranglar turlicha ko‘rinadi. Shu bilan birga, hech bir dasturda skaner
gilingan tasvir uning asl tasviridagi ranglari bilan mos kelmaydi.
Tasvirni bosmaga chiqgarishdagi natija esa avvalgi variantlarning
birortasiga ham mos kelmasligi mumkin. Ba’zi paytda bu farq
hech ganday ahamiyatga ega bo‘lmaydi. Ikkinchi tomondan, rang-
larning o‘zgarishi tasvirdagi biror buyumning «sirli» holda yo‘q
bo‘lishiga olib kelishi mumkin.

Ushbu muammolarni yechishda ranglarni boshqarish katta
ahamiyatga ega bo‘ladi. Yaxshi tizim Kkirish/chiqgish qurilmalari,
turli dasturlardagi ranglarning o‘zgarishini oldini oladi. Rangli profil
qurilmaning rangni tanishida matematik berilishiga e’tibor beradi.
IMlustrator 10 va Photoshop dasturlari ICC (International Color
Consortium —MexnyHnapoanolii Koncopuuym nseta) profilini
ishlatadi, demak, tizimingizda ranglarni boshqarish, qurilma ganday
qilib rangni gayta ishlashi hagida ma’lumotlar bo‘ladi.
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Photoshop dasturida ranglarni boshqarish Edit (IlpaBka)
menyusi orqali chaqiriladigan Color Settings (XapakTepucTHKH
nBeTa) oynasidan boshgariladi. Bu oynada turli holatlar: nashriyot-
dagi muharrirlik ishlari uchun, kompyuter tarmog‘i orqali tasvir-
larni uzatish va bosmaga chiqariladigan tasvirlarni gayta ishlashga
mo‘ljallangan qurilmalar uchun ro‘yxat berilgan.

Adobe kompaniyasining biror dasturida (masalan, Illustrator 10)
rang parametrlari o‘zgartirilgan bo‘lsa, u holda Photoshop dasturini
yuklash paytida bu hagda ma’lumot beruvchi oyna paydo bo‘ladi
(78-rasm). Bu oynani yo‘qotish uchun Synchronize (Cunxponu-
306amp) tugmasiga sichqonchani bosish kerak, shundan so‘ng
Photoshop dasturi boshqa dasturning ranglar parametrlari bilan
moslashtiriladi.

Bu tizim dasturda grafik fayllarni ochganda ranglar bilan ganday
ishlash hagida ma’lumot beradi, rang profillari bor-yo‘qligini tek-
shiradi.

Adobe Gamma

0 The selected file is not an RGE Monitor Profile,

78-rasm. Rang profili o‘zgragani hagida ogohlantiruvchi oyna.

Adobe Gamma | x|

This control panel will allow you to calibrate
your monitor and create an ICC profile for it

" Control Panel

i This ICC profite will be compatible with
\A) ColorSync® on Macintosh® and ICM
2.0 on Windows.

a5 Danee > Oreria
I | |

79-rasm. Adobe Gamma utilitasi oynasining ko‘rinishi.
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Agarda biror tasvirni ikki xil magsadda ishlatmoqchi bo‘lsangiz,
masalan, tarmoq va bosmaga chiqarish uchun, u holda bunda
sizga Adobe Gamma ranglarni boshqgarish utilitasi yordam beradi
(79-rasm).

6.6. Gradiyent va rang bilan bo‘yash (zalivkalar)

Gradiyent asbobi

Photoshop dasturidagi Gradient (I'panuent) — gradiyent asbo-
bini sozlashni ko‘rib chiqamiz.

E] Gradient Tool (I'pagment) [G] — gradiyent rang berish
yoki bitta rangdan boshgasiga o‘tish rangi bilan tanlangan sohani
to‘Idirish.

Parametrlar panelida quyidagi parametrlarni Kiritish mumkin:

Gradient Editor (PenakTupoBanue rpaameHTa) — mavjud
gradiyent turlarini tanlash va yangi gradiyent rang hosil qilish
paneli;

Linear Gradient (JIuneiinblii rpaament) — ajratilgan sohani
chizigli gradiyent bilan bo‘yash;

Radial gradiyent (Pagnanbublii rpaguent) — ajratilgan sohani
radial gradiyent bilan bo‘yash;

Angle gradiyent (KonycosuaHblii rpaguenT) — ajratilgan sohani
konussimon gradiyent bilan bo‘yash;

Reflected gradiyent (3epkaibHblii rpaaMenT) — ajratilgan sohani
oynadagi kabi akslantirish gradiyenti bilan bo‘yash;

Diamond gradiyent (PomOoBWAHBIA TpaaWeHT) — ajratilgan
sohani rombsimon gradiyent bilan bo‘yash;

Reverse — gradiyentdagi ranglarni teskari akslantirish;

Dither — gradiyentdagi ranglarning bir-biriga kamroq sondagi
o‘tishlari evaziga tekisroq gradiyent olish;

Opacity (Henpospaunocth) — gradiyentning shaffofsizligi
miqgdorini o‘rnatish.

Bu asbob tanlanganda Parametrlar panelida chigadigan gra-
diyentlar tanlash panelining o‘ng tarafida joylashgan strelkani bo-
sib, gradiyent namunalari aks etgan to‘plamni ochamiz (80-rasm).

Yangi gradiyent yaratish uchun 80-rasmda strelka bilan ko‘r-
satilgan tugma bosilsa, gradiyentlarni boshqgarish menyusi ochiladi
va u yerdan gradiyentlar ustida yangi gradiyent yaratish, unga nom
berish yoki o‘chirish kabi turli operatsiyalarni bajarish mumkin.

79



|_|—|J i Jovso

80-rasm. Gradiyentlar to‘plami.

Misol ko‘rib chigamiz.

1. Biror rasm ochamiz. Keyin gatlam palitrasida yangi gatlam
yaratamiz. Gradiyent asbobini tanlab, Parametrlar panelidan ke-
rakli gradiyentni tanlaymiz. Shu gatlamga gradiyent bo‘yashni qo‘l-
laymiz (81-rasm).

81-rasm. Yangi qatlam yaratish.

2. Qatlamlar palitrasida ushbu gatlamga 30% lik shaffofsizlik
parametrini qo‘llasak, quyidagi tasvirni olamiz (82-rasm).

Original rasm. 30% lik shaffofsizlik parametrini
go‘llagandan keyingi rasm.

82-rasm. Gradiyentlar to‘plami.
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Photoshopda yangi gradiyent yaratish

Yangi gradiyent yaratish uchun quyidagilarni bajaramiz:

Gradiyent asbobini tanlaymiz. Parametrlar panelida chigadigan
gradiyentlar tanlash maydonining ustiga bosib (83-rasm, to‘rt-
buchak bilan o‘ralgan soha), Gradient Editor — gradiyentlarni
tahrirlash oynasini ochamiz (84-rasm).

83-rasm. Gradiyentni sozlash paneli.

Hafopw —® e
OtMena f
_ Barpyamte..
i F COXDAHMTE... ]
-
WMA:  3eneswid, meoswd, romyGol Hosusl !
TpapmenT: HenpepsieHsR -
Tnapeocte: | 100 |« | %
‘ RoHTpancHE e Toddt
|
|

84-rasm. Gradient Editor mulogot oynasi.

Oynadagi gradiyentning ranglarini sozlash polosasi pastidagi
siljitgichlar (rasmda bittasi o‘rab qo‘yilgan) gradiyentning rang-
larini, yuqoridagilari esa gradiyentning shaffofligini o‘rnatishga mo‘l-
jallangan.

Ortigcha siljitgichni uning ustiga bosib, chetga chiqgarib tashlash
bilan olib tashlash mumkin. Yangi siljitgich qo‘shish uchun esa
ranglarni sozlash polosasining istalgan bo‘sh joyiga sichqoncha
bilan bosish kerak. Gradiyentning bosh nugqtasini belgilab, unga
rang bersak, ranglarini sozlash maydonida kerakli rangni olishimiz
mumkin.

Gradiyentning ranglarini sozlash polosasida istalgan ikkita rang
o‘rnatuvchi siljitgich orasida rang o‘rta nuqtasi mavjud bo‘ladi.
Uni chap-o‘ngga siljitib, gradiyentning ushbu oraliqdagi rang che-
garalarini boshqgarish mumkin (85-rasm).
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Shaffoflikni o ‘rnatuvchi Ikki rang siljitgichi
siljitgichlar orasidagi nugtalar

Rangni o ‘rnatuvchi
siljitgichlar

85-rasm. Gradiyentning ranglarini sozlash polosasi.

=\ 5 ®
E \ |

@® &] @
— KOHTPONEHBIE TOUKN
HenpospauHocTs: % Mosuumn: | 0 % | Yganute |
Liger: [_ — E] TMosuma: D % YaanuTe

86-rasm. Gradiyentning shaffofsizligini o‘rnatish.

Rangning shaffofsizligini o‘zgartirish uchun sichqonchani gra-
diyentning shaffofligini o‘rnatuvchi siljitgichga bosib, Henpo3paunocts
(shaffofsizlik) maydonida kerakli giymatni (misol uchun 50%)
go‘yish kerak. Shunda gradiyent ranglarini sozlash polosasida shax-
mat doskasi shakliga o‘xshash tasvir paydo bo‘ladi, bu gradiyent-
ning ushbu gismda shaffofsizligini bildiradi (86-rasm).

Yangi yaratilgan gradiyentni saglash uchun Imya (nom) may-
donida unga nom beramiz va Hosblii (yangi) tugmachasini bosamiz.

Gradiyentlar ko‘rinishi

Photoshop dasturida gradiyentlar ko‘rinishining quyidagi turlari
mavjud (87-rasm): 1) Linear Gradient (JIuneiinplii rpaauent) —
ajratilgan sohani chizigli gradiyent bilan bo‘yash; 2) Radial gradiyent
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87-rasm. Gradiyent ko‘rinishlari.

He i Henposp .a.:u:!‘loo%‘ﬁ [7] Musepcn  [V] Busepunr (V] Npospaskocts

P

88-rasm. Gradiyent asbobi parametrlari.

(PagnanbHbiii TpaamenT) — ajratilgan sohani radial gradiyent bilan
bo‘yash; 3) Angle gradiyent (KonycoBuaHblii rpaaueHT) — ajratilgan
sohani konussimon gradiyent bilan bo‘yash; 4) Reflected gradiyent
(3epranbHblii rpagMentT) — ajratilgan sohani oynadagi kabi aks-
lantirish gradiyenti bilan bo‘yash; 5) Diamond gradiyent (Pom6o-
BWIHDIA IpaanMenT) — ajratilgan sohani rombsimon gradiyent bilan
bo‘yash.

Parametrlar panelida yana quyidagi parametrlami kiritish mumkin
(88-rasm):

Mode — gradiyentning tasvir ustiga qo‘yilish turini tanlash;

Opacity (Henpo3paunocth) — gradiyentning shaffofsizligi
miqgdorini o‘rnatish;

Reverse (MuBepcusa) — gradiyentdagi ranglarni teskari akslan-
tirish;

Dither (Iu3epunr) — gradiyentdagi ranglarning bir-biriga
kamroq sondagi o‘tishlari evaziga tekisroq gradiyent olish;

Transparency (Ilpozpaunoctn) — gradiyentda shaffoflikni qo‘l-
lashga ruxsat berish.

Photoshopda rang bilan bo‘yash asbobi

Photoshopda rang bilan bo‘yash uchun quyidagi asbobdan
foydalaniladi:

| Paint Bucket Tool (3ammska) [G] — ajratilgan sohani
bitta rang yoki nagsh bilan bo‘yash.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin
(89-rasm):

Fill (3aiuBKa) — rang bilan bo‘yash turini tanlash: Foreground
(Ocnosnoii mBet) — rang yoki Pattern (¥30p) — nagsh bilan bo‘yash;

Mode (Pexum) — rangning tasvir ustiga qo‘yilish turini tanlash;
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89-rasm. Rang quyish asbobi parametrlar paneli.

Opacity (Henpo3paynoctb) — rang bilan bo‘yalgan sohaning
ko‘rinish darajasini o‘zgartirish;

Tolerance (lonyck) — sezuvchanlik — rang bilan bo‘yashda
chegaralar sezuvchanligini o‘zgartirish;

Anti-Aliased (Crnaxusanue) — chegaralarning yoyilishi — rang
bilan bo‘yaladigan soha chegaralarining mayinroq chigishi;

Contiguous (Cmexuble mukcenbl) — fagat ajratilgan sohani rang
bilan bo‘yash;

All Layers (Bee caomn) — ajratilgan soha chegarasida barcha
gatlamlarni bo‘yashni amalga oshirish.

Bu asbobning qo‘llanilishi juda oson: ranglar palitrasidan kerakli
rangni tanlab olamiz va shu rang bilan gatlamni bo‘yaymiz, ya’ni
gatlam ustiga kursorni olib kelib, sichqonchani bosamiz. Shuning-
dek, gatlamni nagsh bilan ham bo‘yash mumkin (90-rasm).

[ [

L O - | samene: [ocmommon e 9]
——— = OCHOBHOW UBET
Yzop

90-rasm. Rang bilan bo‘yash turini tanlash.

Bo‘yash uchun joriy nagshdan boshqga nagshni tanlash uchun
nagshlar palitrasini unga mos tugmachani bosib chiqarish kerak
(91-rasm). Nagshlar ustida nagsh yaratish, yuklash, saglash kabi
amallarni bajarish uchun nagshlar palitrasining chetidagi strelkani
(91-rasmda strelka bilan ko‘rsatilgan) bosib chigariladigan menyu
buyruglaridan foydalanish kerak.

Zanueka: [‘noq b ,D] Pextim: iﬂwsunf& >

91-rasm. Nagshlar palitrasi.
84



Shuningdek, Photoshopda bo‘yashni asosiy menyuning
IlpaBka > Bbimogxuth 3aJuBKYy buyrug‘ini bajarish bilan ham
amalga oshirsa bo‘ladi. Bunda bo‘yash (3aamBka) mulogot oynasi
(92-rasm) ochilib, u yerda bizga bo‘yash uchun rangni tanlash
taklif gilinadi: asosiy yoki fon rangi, rang (ranglar palitrasi ochiladi),
nagsh, qora, 50% kulrang yoki oq. Shuningdek, bu yerda rejim
va shaffofsizlik darajalarini ham o‘rnatsak bo‘ladi.

3anuexa E]

— 0 [
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Yzop
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HenpospayHocTs:
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| Cepuit 50%

Benui

92-rasm. Bo‘yash mulogot oynasi.
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Nazorat savollari

1. Nyutonning yorug‘lik nurini ranglarga bo‘lish tajribasi mohiyatini
aytib bering.

2. RGB, CMYK, HSYV rang modellari hagida ma’lumotlar bering.

3. Gradiyent va rang bilan bo‘yash (zalivkalar) asboblarining vazifa-
larini aytib bering.



Vil BOB. QATLAMLAR BILAN ISHLASH

7.1. Asosiy tushunchalar

Layer (Caoit) — gatlamlarning bir nechtasini ustma-ust joy-
lashishi natijasida tasvir hosil bo‘ladi. Ba’zi dasturlarda bir gatlamda
fagat bitta, ba’zi dasturlarda esa bir nechta obyekt joylashishi mum-
kin. Adobe Photoshop dasturida Layers (Cnom) palitrasi, asosan,
faylda mavjud gatlamlarni ko‘rsatish uchun xizmat giladi. Dasturda
gatlamlarni yashirish va ko‘rsatish quyidagicha amalga oshiriladi:
palitraning chap tomonidagi vertikal gatorda gatlamlarning nomi
to‘g‘risida «ko‘z» piktogrammasi bor bo‘lsa, demak, gatlamlar ko‘-
rinadigan holatda turgan bo‘ladi. Ushbu piktogrammalarni sich-
goncha yordamida o°chirib-yoqish orgali qatlamlarning ko rinishini
bilib olish mumkin. Sichgoncha bilan ushbu vertikal gator bo‘ylab
yurib, gatlamlarni yashirish yoki ko‘rsatish mumkin:

1) agar barcha gatlamlar ko‘rinadigan holatda bo‘lsa, vertikal
gator bo‘ylab yugqoridan pastga (yoki pastdan yuqoriga) garab
«ko‘zlarsning ustidan sichqonchani yurgazilsa, hamma gatlamlar
ekrandan yo‘qolib goladi. Hamma gatlamlar yashirilgan holatda
bo‘lsa, tasvirlar joylashgan soha shaffof (shaxmat doskasi kabi)
holda ko‘rinadi;

2) takror «ko‘zlar» ustidan tortsangiz — gqatlamlar yana
ko‘rinadi;

3) Alt tugmasini bosib turgan holda sichqoncha bilan kerakli
gatlamning «ko‘zini» bossangiz, shu gatlamdan boshga qolgan
gatlamlar yashiriladi; golgan gatlamlarning yana ko‘rinishi uchun,
Alt ni bosgan holda, shu gatlamning «ko‘zi»ga sichqonchani takror
bosish kerak.

Qatlamlar bilan turli amallarni bajarish, ya’ni bir nechta gatlamni
ko‘rsatish, turli stillar va effektlar qo‘llash orqgali tasvirni yanada
sifatli holatga keltirish mumkin.

Qatlamlar bittalab belgilanadi va tahrirlanadi. Belgilangan gatlam
faol qatlam deyiladi. Qatlam faollashganda uning nomining yonida,
«ko‘zdan» o‘ng tomonda mo‘yqalam piktogrammasi paydo bo‘ladi.

Qatlamlarning ketma-ketligini o‘zgartirish bilan tasvirdagi ele-
mentlarning joylashish tartibini o‘zgartirish mumkin.

Layer Options (Ilapametpnl ciaos) — qatlamlar parametrlari
oynasi gatlamlarning nomini o‘zgartirishga imkon beradi, buning
uchun:
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[Normal 'I Opacity:
Lock: + a Fill: New Layer..
. Duplicate Layer...
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E D New Layer Set..
& r,‘ Backpround A i
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v Layer Properties. ..
@. Ol O ®. 1 3], BlendngOptions.
Merge Visible
Flatten Image
Palette Options...

93-rasm. Layers palitrasi.

1) Layers palitrasida biror gatlamning ustida sichqonchaning
chap tugmasini ikki marotaba tez bosing;

2) ochilgan Layer Options (IlapameTpnl cios) oynasiga yangi
nom berib, OK tugmachani bosing.

Layers (Cnon) palitrasi qatlamlarni go‘shish, o‘chirish, ko‘r-
satish/yashirish, nusxalash, guruhlash, bog‘lash va orga fondan
yugorida joylashgan qatlamlarning joylashish tartibini o‘zgartirish
imkonini beradi (93-rasm). Har bir gatlamga go‘yilish va shaffoflik
rejimlarini go‘llab, har bir gatlamni boshqga gatlamlarga qo‘yilishini
boshgarish imkoniyati mavjud. Shu bilan birga, gatlamlarni maska
(mask)ga bog‘lasa ham bo‘ladi.

Standart turdagi gatlamlardan tashqari, Photoshop dasturida
yana ikki xil turdagi qatlamlarni yaratsa bo‘ladi: korrektirov-
kalanadigan qatlam (adjustment layer) — vaqtincha ranglardan
foydalanishda yoki qatlamdagi ranglarni korrektirovkalashda
ishlatiladigan gatlam va tahrirlanadigan matn gatlami (editable
type layer), bu gatlam Type (Teks?) yoki Vertical Type (Beptn-
KaJibHbIH TekeT) asboblarini ishga tushirganda avtomatik ravishda
paydo bo‘ladi. Agarda gatlamga gandaydir effekt qo‘llanilsa (masa-
lan, Inner Glow (Baytpennee csedenne), Drop Shadow (Otopo-
CHTBh TeHb)), gatlam nomi yonida effekt piktogrammasi &. va
go‘llanilgan effektlarni ko‘rsatuvchi menyuni chigarish tugmasi
paydo bo‘ladi.
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Fagat joriy qatlamnigina tahrirlasa bo‘ladi. Qatlamni tanlash
uchun Layers palitrasidagi qatlam nomiga sichqonchani bosish
kerak.

Yangi faylning foni shaffof rangda bo‘lishi uchun File > New
(@aiin > Hoeslit) buyrug‘ini bajarib, ochilgan mulogot oynasida
Contents (Conepxxanne) maydonida Transparent (IIpo3paunbiii)
bandini tanlash kerak.

Har bir gatlam uchun Blending Options (Onuyun cMenmBanus )
buyrug‘ini qo‘llab, ochilgan Layer Style (Ctun caos) paneli mulo-
got oynasi orqali turli qo‘shimcha effektlar (stillar) go‘llash mumkin
(94-rasm). Bu muloqot oynasi Layers palitrasida biror qatlamning
ustida sichgonchani ikki marta tez bosish bilan chiqgariladi. Agar
avvalroq biror gatlamga ushbu panelning biror effekti qo‘llangan
bo‘lsa, u holda bu gatlam nomining yonida paydo bo‘ladigan effekt
piktogrammasi &, ni bosish bilan shu go‘llangan effektlar ro‘yxatini
ochish mumkin. Ro‘yxatdagi istalgan effektni tanlash bilan Layer
Style paneli oynasini to‘liq holda ochish mumkin.

Ushbu panel obyektlar uchun tayyor effektlarni qo‘llash im-
konini beradi. Ushbu effektlar bilan tanishib chigaylik:

Drop Shadow (Hapyxnasa tenb) — tashqi soya — obyektga
tashqi soya berish;

Layer Style : = ﬂ
= — General Blending - —
Blending Options: Custom Blend Moda: [Normal | Cancel I
I™ Drop Shadow ‘ o p—— o New Style I
I¥ Inner Shadow ‘ S
Advanced Blending i v Preview
™ Cuter Glow | Fil opacity) e 35 %
7 Inner Glow | Channelsi FrRVGe Ve
¥ Bevel and Emboss knockeut: [None = I I
| [V Blend Interior Effects as Group
¥ Contour [~ Blend Clipped Layers as Group
I™ Texturs [V Tranzparency Shapes Layer
< | I Layer Mask Hides Effects
¥ Satin [~ Wector Mask Hides Effacts

|
¥ Color Overlay

Blend If: IGnv |

This Layer: o 255

I Gradient Overlay
I™ Pattern Owverlay

I
I™ Stroke a =

|
| Underlying Layer: 0 255
|

94-rasm. Layers Style paneli.
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Inner Shadow (BuytpenHaa tennb) — ichki soya — obyektga
ichki soya berish;

Outer Glow (BHenHee Mepuanue wimm Jyub) — tashqi miltillash —
obyektga tashqgi miltillash yoki nur effektini qo‘llash;

Inner Glow (Buyrpennee Mepuanne wimm Jayab) — ichki miltillash —
obyektga ichki miltillash yoki nur effektini qo‘llash;

Bevel and Emboss (JIya u Tenb) — nur va soyalar — obyektga
nur va soyalar effektini berish;

Color Overlay (Hanoxenune npera) — rang bilan qoplash —
obyektni biror rang bilan qoplash;

Gradient Overlay (Hanoxenne rpaamenta) — gradiyent bilan
goplash — obyektni gradiyent bilan goplash;

Stroke (O0Boaka) — o‘rab chiqish — obyektning chetlarini
chiziq bilan o‘rab chigqish.

Har bir effektning o‘ziga xos sozlash parametrlari mavjud
bo‘lib, ularni o‘zgartirish orgali olinayotgan natijani turlicha ko‘ri-
nishga keltirish mumkin.

Obyektga ma’lum bir effekt go‘llangandan so‘ng Layers panelida
ular haqgidagi ma’lumot ko‘rinib turadi. Effekt ustida sichqonchani
ikki marta bosish orqali o‘rnatilgan parametrlarni o‘zgartirish mumkin.

«Sehrli tayoqcha» asbobi tanlanganda parametrlar panelida Use
All Layers parametrining tanlanishi ushbu asbobning hamma gat-
lamlarga, aks holda fagat joriy qatlamga qo‘llanishini ta’minlaydi.

7.2. Unsharp Mask filtridan foydalanish

Agarda tasvir o‘lchamlari yoki ruxsat etilgan qgobilligini o‘zgar-
tirsangiz, bunda Image > Image size buyrug‘i mulogot oynasidagi
Resample Image (Mutepnoasimusi) maydonida bayroqcha qo‘yilgan
bo‘lsa, so‘ngra tasvirni CMYK rejimiga o‘tkazsangiz yoki tasvirda
o‘zgartirishlarni (Tpancgopmairsr) amalga oshirsangiz, u holda
interpolatsiya natijasida tasvir aniqligi yo‘qoladi.

Unsharp Mask (Macka nepe3koctn) filtri yordamida tasvir-
larning ravshanligi (pe3kocts) fokusirovka (aniglashtirish) gilinadi.
Bu filtr yorqinliklari fargi siz ko‘rsatgan giymatga teng bo‘lgan
barcha qo‘shni piksellarni topib, ularni siz ko‘rsatgan giymatgacha
orttiradi. Bu filrtning quyidagi sozlash parametrlari mavjud: Amount
(Koamuectso) — ravshanlik darajasi; Radius (Panuayc) — ravshanlik
darajasi qo‘llaniladigan qo‘shni piksellar migdori; Threshold (Ilopor) —
filtr go‘llanilishi uchun piksellarning yorqinlik darajasi farqi ganday
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bo‘lishi kerakligini ko‘rsatuvchi parametr, bu parametr giymati
ganchalik kichik bo‘lsa, shuncha ko‘p piksellar ravshanligi oshi-
riladi.

Unsharp Mask filtrining parametrlarini turlicha giymatlar bilan
sozlab go‘llanilishiga misol ko‘rib chigaylik.

1. Biror rasm tanlaymiz (95-rasm).

95-rasm.

2. Filter > Sharpen > Unsharp Mask (®uisTp > Pe3rocts >
Hepe3koe mackupoBanue) buyrug‘ini tanlaymiz, filtrni quyidagi para-
metrlar: Amount — 160%, Radius — 1,5, Threshold — 0 (96-rasm)
bilan rasmga qo‘llab, quyidagi natijani olamiz (97-rasm).

Unsharp Mazk E3

= " loow &
amount: [lE0 %

Badis: IS5 pheels

S
Trreshold: [o levels

o

96-rasm. Unsharp Mask filtri mulogot oynasi.
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97-rasm. Filtrni go‘llagandan keyingi natija.

Amount parametri piksellarning kontrastligi ganchalik yugori
bo‘lishini belgilaydi. Amount parametrining giymati katta bo‘lganda,
yugori kontrastli sohalarda oreol (yorug® gardish) paydo bo‘ladi.
Yugori sifatli bosma tasvirlarni olish uchun uning giymatini 150—
200% oraligda olish tavsiya etiladi.

3. Radius parametrini sozlash birmuncha giyin bo‘ladi, buning
uchun tasvirning natijaviy o‘lchami, tasvirda nima berilganini aniq
bilish lozim. Radius parametrining qiymatini 0,1 dan 250 gacha
oraligda berish mumkin. Yugqori ruxsat etilgan qobillikka ega tas-
virlar uchun uning giymatini 1 va 2 qilib olish tavsiya etiladi. Bu
parametrning kichik giymatlarida fagat chegaraviy piksellar, katta
giymatlarida esa ko‘proq sohadagi piksellar ravshanlashtiriladi. Bu
parametrning effekti printerga garaganda ko‘proq ekranda bilinadi.

Kontrastligi past bo‘lgan tasvirlar uchun katta giymatli radius
va murakkab bo‘lgan yuqori kontrastdagi tasvirlarga esa kichik
givmatli radius berish kerak.

Radius parametrining qiymati gancha katta bo‘lsa, Amount
parametrining giymatini shuncha kichik olish kerak va aksincha.

Misol uchun, yuqoridagi rasmga Unsharp Mask filtrini quyidagi
parametrlar: Amount — 130%, Radius — 6,0, Threshold — 0
(98-rasm) bilan go‘llab, quyidagi natijani olamiz (99-rasm).

4. Threshold (Ilopor) parametrining giymatlari gancha kichik
tanlansa, shuncha ko‘p piksellar o‘zgartiriladi. Agarda giymati 0
qilib olinsa, tasvirdagi barcha piksellar ravshanlashtiriladi. Qiymati
gancha katta bo‘lsa, yuqori kontrastli joylarning chegaralariga yagin
joylarda ravshanlik yuqorilashadi va past kontrastlilarda ravshanlik
kam miqgdorda o‘zgaradi.
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Amount: |l33 %
Radius: IE pixels

Threshold: F levels
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98-rasm. Unsharp Mask filtrining parametrlarini sozlash.

99-rasm. Filtrni go‘llagandan keyingi natija.

Agarda Threshold parametri qiymatini o‘zgartirsak, Amount
va Radius parametrlarining giymatlari ham ko‘p bo‘ladi, bunda
chegaraga yaqin joylardagi kontrastlik ortadi.

Tasvirda nosozliklarni (mym — shovgin) yo‘qotish uchun,
Threshold parametr giymatlarini 8—20 oraligda berish kerak.

Unsharp Mask filtrini quyidagi parametrlar: Amount — 160%,
Radius — 1,5, Threshold — 15 (100-rasm) bilan qo‘llab, quyidagi
natijani olamiz (101-rasm).
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Unsharp Mask

Radius:[15 pixels

==
Threshokd: [15] levels
=

100-rasm. Unsharp Mask filtrining parametrlarini sozlash.

101-rasm. Filtrni qo‘llagandan keyingi natija.

E

Nazorat savollari

]

1. Yangi gatlam ganday yaratiladi?
2. Layer Style panclida qo‘llash mumkin bo‘lgan effektlarga izoh

bering.
3. Unsharp Mask filtridan nima uchun foydalaniladi? Uning ganday
parametrlari mavjud va ular ganday vazifani bajaradi?
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VIII BOB. FILTRLAR VA MAXSUS EFFEKTLAR

Photoshop dasturidagi filtrlar tasvirga bujmaytirish, o‘zgartirish,
turli rassomchilik usullarini go‘llash, mozaika yoki oynavand vitraj
holiga keltirish kabi turli xil maxsus effektlarni qo‘llash, kontrast
va aniglikni oshirish kabi imkoniyatlarni beradi. Photoshop
dasturiga juda ko‘plab filtrlar to‘plami kiradi. Unga yana boshqga
go‘shimcha filtrlarni gqo‘shish mumkin. Biror filtrni faollashtirish
uchun asosiy menyuning Filter (PuansTphl) bandiga kirib, u yerdan
kerakli filtrlar guruhini tanlab, so‘ngra filtrning o‘zini tanlash
kerak. Tanlab olingan filtrni tasvirga yoki belgilangan sohaga qo‘l-
lash mumkin.

Ko‘p filtrlarda sozlash oynachalari mavjud bo‘lib, unda bir
vaqtning o‘zida filtrni sozlab, natijasini kuzatish mumbkin.

Asosiy filtrlar guruhini ko‘rib chigamiz va ularga gisgacha
izoh beramiz. Ochig‘ini aytganda, filtrlarni ta’riflashdan ko‘ra,
ularning natijasini ko‘rish samaraliroq bo‘ladi.

Artistic (IMmuTauus pa3HbIX NpueMoB pucoBanms) — turli
rassomchilik usullarini go‘llash.

Blur (PazmbiTe) — Kontrastni kamaytirish yoki ranglarni
yoyish.

Brush Strokes (Mmatanmust padoTsl KHCTH) — mo‘ygalam bilan
ishlash imitatsiyasi.

Distort (ledpopmanus) — deformatsiyalash.

Noise (Padota ¢ mymom u nederramn) — shovqin va defektlar
bilan ishlash, ularni qo‘shish yoki olib tashlash.

Pixelate (Pa6ota ¢ marcemsima) — piksellar bilan ishlash, ularni
turli gonuniyatlar bo‘yicha birlashtirish.

Render (Besikue ucckycTBeHHble 3ddektn) — turli sun’iy
effektlarni qo‘llash, axborotni grafik ko‘rinishda aks ettirish jarayoni.

Sharpen (Pe3koctb) — tasvirni aniqroq qilish.

Sketch (MImutanmsi BCSIKMX CTHJel m npuemos) — turli stillar
va usullarni qo‘llash.

Stilize (Ctumm3zammsi) — turli stillar imitatsiyasi.

Texture (Cosnanme tekcTyp) — teksturalar yaratish.

Filtrlarning go‘llanilishiga biror misol korib chigamiz. Ushbu
misolni turli rasmlarning kompozitsiyasi sifatida bajaramiz. Bu
kompozitsivaning natijaviy ko‘rinishi 102-rasmda keltirilgan.
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102-rasm. Bajarilishi kerak bo‘lgan kompozitsiya ko‘rinishi.

Kompozitsiyani bajarish uchun quyidagi ketma-ketlikdagi ish-
larni bajarishimiz kerak:

1) ikkita — tog® va dengiz tasvirini olish;

2) tasvirlarni bir-birining ustiga qo‘yish va vektor maskani
gradiyent bilan go‘llab, ikki tasvirning estetik qo‘shilishiga erishish;

3) ayiglar, delfinlar va qushlar rasmini qo‘yish;

4) hajmli zarhal yozuv yaratish;

5) bajarilgan ishni psd va jpg formatlarida saglash.

Ishni boshlaymiz:

1) ikkita tasvirni olamiz (103-rasm);

2) Lasso asbobini tanlab, tuslash (Pactymeska) maydonida
20 piksellik giymatni o‘rnatamiz (104-rasm);

3) Lasso asbobi yordamida biror sohani belgilaymiz va shu so-
hani Move asbobi yordamida ikkinchi tasvirga o‘tkazamiz (105-rasm);

4) o‘tkazilgan rasmni kerakli joyga va kerakli o‘lchamlar bilan
joylashtiramiz (106-rasm);

5) hosil bo‘lgan Qatlam 1 (Caoit 1)ga vektorli maskani qo‘l-
laymiz (107-rasm);
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103-rasm. Tanlangan tasvirlar.
IE Adobe Photoshop
@afin  PeaakTvp 6 Cnoit Bel

P ® |j|’*__‘|F B,_] PacTywesaTe: lﬂ"i,

104-rasm. Lasso asbobini tanlash va
kerakli parametrlarni o‘rnatish.
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105-rasm. Lasso yordamida kerakli sohani belgilab, ikkinchi tasvirga
o‘tkazish.
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& Adobe Photoshop
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107-rasm. Qatlam 1 ga vektor maskani qo‘llash.
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6) Gradient asbobini tanlab, gradiyentlar palitrasidan Black,
White (qoradan oqqga o‘tish) gradiyentini tanlaymiz (108-rasm);

I Adobe Photos hop

®ain PeaakTvpoeanme Msofpawerwe Cnod Be
-

B [ aouoo

108-rasm. Gradiyentlar palitrasi.

Qe s [ N1=]+

7) Parametrlar panelidan chizigli gradiyent .r»mmmwm turini
tanlab, tasvirimiz ustidan gradiyent tortamiz (109-rasm);

& Adobe Photoshop
i i Choi DureTp NpoowoTp Ceo Onpassa

@ - | T | DRI | Peow [hesammn %] Hanpeses [ 0o 3] | O El s
ey

PN/ HAERN AT

B CE=r ol sl

109-rasm. Gradiyent tortish.
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8) gatlamlarni birlashtiramiz (Cmoit > O0beJHHATE ¢ BHIAMBIM);

9) ayiglar, delfinlar va qushlar rasmini Magnetic Lasso (magnitli
lasso) asbobi (20 piksellik tushlash parametri) bilan kesib, tasvirga
go‘yamiz (110-rasm);

Tain o Crost DwwTp MpoowTy oo Cnpdess

f - [T ORI | oo (o ] accesps [ 3] | Dieaeon Bl o Bl fpcspemsce

Wl Zimniye fantazii.psd @

CEler cRbN /X g
PNz s : ‘

e
2215\ "

110-rasm. Ayiglar, delfinlar va qushlar rasmini go‘yish.

10) endi yozuvni qo‘shamiz. Type (Teket) asbobini tanlaymiz,
parametrlar panelida shriftning o‘lchamini 72 pt va rangini sariq
qilib o‘rnatamiz hamda yozuvni kiritamiz (111-rasm);

111-rasm. Yozuvni Kkiritish.
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11) Cnoit > Dddekrsl cios > Tenn (soya) buyrug‘ini tanlab,
quyidagi sozlashlarni kiritamiz: myrtHoBatocTs (xiralik) — 75%,
paccrognune (masofa) — 16 pks, paszopoc (siyraklik) — 10%, pasmep
(o‘lcham) — 7 pks va yozuvga soya effektini qo‘llaymiz (112-rasm);

YAMROUTH ALBOULIN Tt

112-rasm. Yozuvga soya effektini qo‘llash.

12) Caoii > DddekTn cnoa > Baemmnnmii cset (tashqi nurla-
nish) buyrug‘ini tanlab, quyidagi sozlashlarni kiritamiz: noaynpos-
paunocts (yarim shaffoflik) — 75%, texnika — msrkuii (yumshoq),
pasopoc (siyraklik) — 7%, pasmep (o‘lcham) — 114 pks, obmacTb
(soha) — 50% (oblast) soha va yozuvga tashqi nur effektini qo‘llaymiz
(113-rasm);

12) Cuoii > DddekTnl cioa > Pemsednocts (relyeflik) buy-
rug‘ini tanlab, mulogot oynasida rasmdagi kabi sozlashlarni ki-
ritib, yozuvga relyeflik effektini qo‘llaymiz (114-rasm);

13) Cnoit > Dddextn cios > ITpux (shtrixlash) buyrug‘ini
tanlab, mulogot oynasida rasmdagi kabi sozlashlarni kiritib, yozuvga
shtrixlash effektini go‘llaymiz (115-rasm);

14) kompozitsiyamiz tayyor bo‘ldi, uni psd va jpg formatlarida
saglab go‘yamiz (10-rasmga q.).
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114-rasm. Yozuvga relyeflik effektini qo‘llash.
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116-rasm. Tayyor kompozitsiyaga yana bir misol.

&] Nazorat savollari
1. Filtrlarning vazifalari nimalardan iborat?
2. Asosiy filtrlar guruhlarini ayting va ularga gisqacha izoh bering.
3. Matnga ganday effektlar go‘llash mumkin?
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IX BOB. ADOBE PHOTOSHOP DASTURNING
INTERFEYSI

9.1. Asosiy tushunchalar

Adobe Photoshop dasturida matn bilan ishlashning bir gancha
imkoniyatlari mavjud.

L Type (Tekcr) matn bilan ishlash asbobi yordamida ekranga

yozuvlarni chigarish mumkin. Asbob tanlangach, ishchi varagning
yozuv yozilishi lozim bo‘lgan gismida sichqoncha bir marta bosilib,
yozuv kiritiladi.

Yozuv kiritib bo‘lingach parametrlar panelida chigadigan bu

asbobga tegishli bo‘lgan @ « tugmalari orgali matnga kiritilgan

yozuvni gabul qilish yoki bekor qgilish mumkin. Matnga oid barcha
parametrlarni o‘mnatish Character (Cumon) paneli yordamida
amalga oshiriladi (117-rasm). Bu yerda shrift, uning o‘lchami,
so‘zlar orasidagi masofa, simvollarning balandligi, terish gatoridan
baland yoki pastda (daraja ko‘rsatkichi yoki indeksda) joylashishi,
gatorlar orasidagi interval, simvollar orasidagi masofa, simvol keng-
ligi, rangi kabi parametrlarni o‘rnatish mumkin.

Bu asbobning quyidagi xillari T Horizontsl Type Tool
mavjud: Horizontal Type Tool | T Vertical Type Tool
(T'opu30HTANBHBIA TEKCT) — gOTi- if* Horizontal Type Mask Tool
zontal holatda matn kiritish; Vertical |1 vertical Type Mask Tool
Type Tool (BepTHKANbHBIA TEKCT) —
vertikal holatda matn kiritish; Horizontal Type Mask Tool (T'opu-
30HTAJbHLINH TeKCT-Macka) — gorizontal holatda matn-maska ki-
ritish; Vertical Type Mask Tool (BepTHKaNbHBIA TEKCT-Macka) —
vertikal holatda matn-maska kiritish.

Parametrlar panelida quyidagi parametrlarni berish mumkin:

matn yo‘nalishini o‘zgartirish;

matnning shriftini o‘zgartirish;

simvollarning ko‘rinishini o‘zgartirish (galin, yotiq, tagi chizilgan);

shift o‘lchamini o‘zgartirish;

simvolning chetlari ko‘rinishini o‘zgartirish;

matnning abzasda joylashishi: chap, markaz yoki o‘ng tomon
bo‘yicha tekislash holatini o‘zgartirish;

matn rangini o‘zgartirish;

- = - =
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117-rasm. Character paneli. 118-rasm. Paragraph pancli.

Paragraph (A63am) paneli yordamida matnning biror abzasiga
tegishli parametrlarni: matnni o‘ng, chap chegara yoki markaz bo‘-
yicha tekislash, abzas va otstuplarni o‘rnatish mumkin (118-rasm).

Type asbobi ishlatilganda yangi matn gatlami paydo bo‘ladi
(Text Layer).

9.2. Matnni deformatsiyalash va
unga turli effektlar berish

Tashrif qog‘ozlari (vizitka), reklama afishalari va shu kabilardagi
matnga turli dizayn va ishlovlar berishga ehtiyoj bo‘ladi.

Warp Text paneli yordamida matnni turli xil trayektoriyalar
bo‘yicha deformatsiyalash mumkin (119-rasm). Bu panel chiqa-
rilgach, uning mulogot oynasida matnni ganday trayektoriya bo‘-
yicha joylashtirish kerakligi, egrilik radiusi, gorizontal va vertikal
og‘malik darajasi o‘rnatiladi. So‘ngra OK tugmasini bosish bilan
ko‘rsatilgan parametrlar matnga qo‘llanadi.

Matnni belgilab Styles panelidan kerakli texturani tanlab, matn-
ni shu texturada bo‘yash mumkin (120-rasm).

Biror misol ko‘rib chigaylik. «TUTS.KHK.UZ» matnini kiritib,
unga turli effektlar qo‘llash orqgali, «tuprogli» matn (121-rasm)
tayyorlash ketma-ketligini bajaramiz:

1) oq fonda xchlagan o‘lchamda yangi oyna ochamiz va qora
rangda matnimizni yozamiz:

TUTS.KHK.UZ
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119-rasm. Warp Text pancli. 120-rasm. Styles paneli.

121-rasm. «Tuprogli» matn ko‘rinishi.

2) Filter > Stylize > Diffuse filtrini qo‘llaymiz. Bu filtr sifatli
tasvirlar hosil qgilishning usullaridan biri bo‘lib, sochiluvchan (dif-
fuz) dizering (diffused dithering) asosida ishlaydi. Uning mohiyati
shundan iboratki, piksellar tasodifiy (yoki psevdotasodifiy) ravishda
hosil gilinadi.

Agar har bir gradatsiya uchun tasodifiy piksellar hosil gilsak,
unda hatto rastrlarning doimiy rangli piksellari uchun ham tartib-
lashgan struktura hosil bo‘lmaydi. Bu notekis (matoviy) sirtdan
nurning sochilib gaytishiga o‘xshash effekt beradi (122-rasm).

Matnimizga boshqa filtrlarni ham qo‘llaymiz:

3) Filter > Stylize > Emboss filtrini quyidagi parametrlar bilan
qo‘llaymiz: Angle (burchak) — 90°, Height (balandlik) — 2 pks
(123-rasm);

4) Flter > Texture > Grain filtrini qo‘llaymiz (124-rasm);

5) Layer > Layer style > Drop shadow effektini qo‘llaymiz
(125-rasm);

6) Layer > Layer style > Inner Glow effcktini qo‘llaymiz
(126-rasm);
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122-rasm. Filter > Stylize > Diffuse filtri.
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123-rasm. Filter > Stylize > Emboss filtri.

7) Layer > Layer style > Satin effektini qo‘llaymiz (127-rasm);

8) Layer > Layer style > Stroke effektini qo‘llaymiz (128-rasm)
va yakuniy natijani olamiz.

Shunday qilib tuprogli matn bajarildi (129-rasm).
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125-rasm. Layer > Layer style > Drop

shadow cffekti.
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126-rasm. Layer > Layer style > Inner Glow effekti.
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127-rasm. Layer > Layer style > Satin cffekti.
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128-rasm. Layer > Layer style > Stroke cffckti.

129-rasm. Yakuniy natija — «tuprogli» matn.

9
u Nazorat savollari

1. Matn kiritish asbobining ganday turlari mavjud? Ularga izoh bering.

2. Character va Paragraph pancllariga qisqacha izoh bering. Ular
orgali matnning ganday parametrlarini o‘rnatish mumkin?

3. Matnlarni biror trayektoriya bo‘yicha joylashtirish ganday amalga

oshiriladi?
4. Matnlarga ganday effektlarni go‘llash mumkin?
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X BOB. BIR XIL VA RANGLI KORREKSIYA

Photoshop dasturi nugtayi nazaridan, har bir piksel 0 (qora) dan
255 (0q) gacha bo‘lgan yorug‘lik giymatiga ega. Tasvirda qo‘llanilgan
to‘liq yorug‘lik gismi tasvirning bir xil diapazoni deb yuritiladi. Bir
xil diapazon gancha keng bo‘lsa, detallarni gayta ishlash shuncha
yaxshi va ranglar «chuqur» bo‘ladi. Ushbu masalani yorug‘lik va
soyalar korreksiyasi yechadi.

Agarda bir xil diapazonni uchta bo‘lakka bo‘lsak, unda eng
gorong‘i gismi soya (shadows), eng och qismi yorug‘lik (highlights),
ular orasida joylashgan gism o‘rta tonlar (midtones) deb ataladi.
Tasvirning eng kerakli fragmenti ushbu uchta gismdan birida
joylashgan bo‘lib, u yerda ottenkaning eng maksimal miqgdori
bo‘lishi kerak. Muhim tonal diapazonning kontrastini ko‘paytirish
tonal korreksiyani tashkil qgilishdan iborat bo‘ladi.

Bosma qurilmalari juda qora va juda och tonlarni yomon gabul
giladi. Odamning ko‘zi o‘rta yorug‘lik sohalarni yaxshi gabul giladi.
Shuning uchun korreksiya tushunchasi, agarda eng kerakli detallar
yorug‘lik va soyalardan uzoqda joylashgan bo‘lsa, tonal diapa-
zonning o‘rta ton tomonga silijishini o‘z ichiga oladi.

Rasmlarning oqarib ketishi, noto‘g‘ri skanerlash, tasvirga olish
sharoitining buzilishi va boshqga holatlarda tasvirlar xira chiqgishi
mumkin. Bu nugsonlarni tuzatishga bir misol ko‘rib chigamiz.

Bizga bir xonadonning juda qorong‘i ekspozitsiyasi berilgan
(130-rasm). Bunday tasvir nugsoni amaliyotda juda ko‘p uchraydi.
Bunday nugsonli tasvirlarni korreksiyalash gammani (gamma 0
dan 10 gacha shartli birlikda o‘lchanadi), ya’ni tasvirning o‘rta
tonlarini o‘zgartirishdan iborat bo‘ladi. Buning uchun o‘rta tonlar
katta yoki kichik yorug‘lik tomonga siljitiladi. Shunga garamasdan,
tonal diapazon o‘zgarmasdan qoldi. Tonal diapazonni korreksiyalash
algoritmini bajaramiz:

1. 130-rasmdagi gistogrammadan ko‘rinib turibdiki, butun yorug*-
lik intervalida detallar mavjud, shuning uchun bu sathni kesib
tashlash yorug'lik gismidagi detallarning yo‘qolib ketishiga olib
keladi. Ammo pik gistogrammalar soyalarda joylashgan. Agarda
tasvir bir necha barobar yorug‘roq bo‘lsa, tasvirning sifati bundan
yutishi mumkin. Tasvirni gamma korreksiyalash uchun Levels
(¥posun) buyrug‘i mulogot oynasidagi gistogrammadan foydala-
namiz (131-rasm). Histogram (Gistogramma) buyrug‘i fagat tonal
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Input Levels: O 334 | 255

131-rasm. Gammani korreksiyalash va korreksiyalangan tasvir.

diapazon to‘g‘risida axborot olish uchungina qo‘llaniladi va undan
korreksiyalash uchun foydalanib bo‘lmaydi.

Tasvirning eng qorong‘i piksellariga nollik yorug‘lik beramiz,
eng ochlariga maksimal yorug‘lik beramiz. Shunda tasvirning ton-
lari to‘lig diapazonli yorug‘likka cho‘ziladi. Bunday amal tonal
diapazonning kengayshi deyiladi.

2. Levels (¥YpoBuu) buyrug‘i oynasini ochamiz. Kulrang sil-
jitgich (131-a rasm) o‘rta tonlarni ko‘rsatib turibdi. Oyna ochi-
lishida gamma birga teng, Input Levels (Bxoaubie ypoBan) guruhi
o‘rta maydonchasida akslantirilgan.

3. Siljitgich soyalar tomonga suriladi. Gamma kattalashadi,
tasvir yorginlashadi (131-b rasm). Bu yerda soyalar va yorug‘liklar
o‘zgarmaydi.

4. Tasvirni keraki formatda saglaymiz.

9 ;
u Nazorat savollari

F ]

1. Levels buyrug‘ining vazifasi nimadan iborat?
2. Histogram buyrug‘ining vazifasi nimadan iborat?
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XI BOB. RASMLARNI RETUSHLASH VA
TIKLASH

11.1. Yuvilish effektini beruvchi filtrlar

Yuvilish filtrlari belgilash yoki tasvirni yumshatish yoki tasvir-
ning o‘zini retushlash uchun qo‘llaniladi. Ular tasvirdagi ma’lum
chiziglar va soya joylarning keskin chegaralari yonidagi piksellarni
o‘rtachalashtirish hisobiga o‘tishlarni yumshatadi.

Yuvilish filtrlarini tanlash uchun asosiy menyuning Filter
(®umstp) bandi  Blur (PasmeiTHe) buyrug‘ini tanlab, ochilgan
ro‘yxatdan tegishli yuvilish filtrini tanlaymiz. Ular bilan tanishib
chiqaylik:

Smart Blur (Ymuoe pasmbiTie) — <«aglli» yuvilish filtri asosan
tasvirning yengil timdalangan va donadorlik (3epamcTocTs) kabi
mayda kamchiliklarini bataraf gilish uchun qo‘llaniladi. Bu kam-
chiliklar ko‘pincha ayrim piksellarning kattalashishi bilan ular kon-
trastining keskin farq qilishi bilan bog‘liq. Ushbu filtr tasvirning
keskin tonli va rangli o‘tishlar mavjud bo‘lmagan sohalarni yum-
shatadi. Tasvir chetlari qoniqgarli darajada qoladi, lekin mayda
detallari yo‘qoladi. Kuchli yuvilishda tasvir xuddi bo‘yoq bilan
bajarilgan rasmga o‘xshash bo‘lib goladi. Quyidagi sozlash para-
metrlari mavjud:

Radius (Pagnyc) — siljitgich yordamida yuvilish uchun nug-
talarni topish sohasi aniglanadi. Radiusning giymati kattalashishi
bilan yuvilishning holati asta-sekin kattalashib boradi, so‘ngra
yuvilish darajasi o‘zgarmas bo‘lib qoladi.

Threshold (I1opor) — piksellar orasidagi tonli farq ularni bartaraf
etishgacha gqanday bo‘lishini belgilaydi. Bu parametr giymati gancha
katta bo‘lsa, shuncha ko‘p tasvir schasi yuvilishga uchraydi.

Quality (KauyectBo) — yuvilish sifatini belgilaydi. Uning 3 ta
turidan bittasini tanlab olish mumkin: Low (Hu3koe) — past;
Medium (Cpennee) — o‘rta va High (Buicokoe) — yugori sifatli
yuvilish.

Mode (Pexxum) — yuvilish uchun sohani belgilaydi. Uning,
0°‘z navbatida, 3 ta rejimi mavjud: Nermal (Hopmanbhbliii) — butun
tasvir; Edge Only (Tonbko kpasi) — fagat chegaralar, natijada oq-
gora tasvirni olish mumkin; Overlay Edge (CoBmemenue) —
yuqoridagi ikki rejimning ikkalasini qo‘llash.
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Gaussian Blur (PasmbiTHe mo Tayccy) — Gauss bo‘yicha
yuvilish ko‘p ishlatiladigan filtrlardan biri bo‘lib, u bilan ko‘rsatilgan
radius giymati bo‘yicha tez yuvilish amalga oshiriladi. Bu filtr
tasvirni past chastota bilan detallashtirib, tuman effektini berishi
mumkin. Bundan tashgari, bu filtr bilan tasvirda gandaydir ele-
mentni olib tashlash qulaydir, masalan, skaner orqali yaratilgan
rastr polosasini yo‘q qilish uchun tasvirning rastrli strukturasini
o‘zgartirish. Buning uchun katta bo‘lmagan radius beriladi.

Lens Blur (Pa3MbiTHe npH Majoii riy0WHe pe3KOCTH) — rav-
shanlikning kichik darajadagi yuvilish filtri tasvirga hajm effektini
yaratishga yordam beradi, ya’ni bosh ko‘rinishdagi obyektlar o‘z-
garmay qoladi, ammo orqga plandagi ko‘rinish yuviladi va tasvir
xuddi optik linza orgali ko‘ringandek effekt beradi.

Ushbu filtr alohida mulogot oynasiga ega bo‘lib, unda quyidagi
sozlash parametrlarini berish mumkin: Preview (IIpocmotp)
parametrida natijani aniqroq ko‘rish uchun More Accurate (Tounee)
bandi, tezroq ko‘rish uchun esa Faster (boicTpee) bandi tanlanadi.
Bundan tashqari, boshqga sozlash parametrlari ham mavjud bo‘lib,
ularning tasvirga ko‘rsatadigan ta’sirini o‘zingiz mustaqil ko‘rib
chiqishingiz mumkin.

11.1. Oq-qora tasvirlarni gayta ishlash,
eskirgan rasmlarni tiklash

Biror rasmni retushlash algoritmini ko‘rib chigamiz (132-rasm).

132-rasm. Berilgan rasmning asli va retushlashdan keyingi ko‘rinishi.
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132-rasmdagi fotosuratning asl ko‘rinishining pastki gismi chap
tomonida ko‘rsatilgan gizchadagi defektlar olib tashlangan va
retushlangan.

Bajarilish tartibi quyidagicha:

1) skanerlangan rasmni oq-qora rejimga o‘tkazamiz: W306pa-
xenne > Pexum > UYepHo Oelblii;

2) rasm joylashgan gatlamning nusxasini yaratamiz, buning
uchun gatlamlar palitrasida gatlamning nomi ustida sichqonchaning
o‘ng tugmasini bosib, hosil bo‘lgan menyudan JybéimpoBaTs cioi
buyrug‘ini bajaramiz;

3) keskin kontrastlik va yorug‘likni boshqgarish buyrug‘ini
(N306paxenne > Koppekmua > fApkocts/KonTpacHocTs) tanlab,
bir qatlamda ochroq obyektlarni va ikkinchi gatlamda esa to‘qroq
obyektlarni sozlaymiz;

4) ochroq obyektlar sozlangan gatlamni asosiy gatlam qilib
olamiz;

5) yumshoq ofchirg‘ich asbobini qo‘llab, asosiy gatlamning
to‘qroq joylarini tozalaymiz va ikkinchi gatlam bilan hosil bo‘lgan
tasvirni ko‘rsatamiz;

6) 4 tiklash mo‘ygalami asbobi bilan asosiy qatlamning katta
va o‘rta defektlarni olib tashlaymiz;

7 @ asbob yordamida retushlanayotgan obyektdan g‘adir-
budurliklarni olib tashlaymiz;

8) gatlamlarni birlashtiramiz: Cioii > QO0beJeHHTb ¢ BUIBIMAM

9) rasmni RGB rejimiga o‘tkazamiz: M300paxenne > Pexam >
RGB ner. Ranglar balansini sozlash buyrug‘ini qo‘llab, rasmni
ranglashtirish mumkin: M3o0paxkenne > Perymapoern > bananc
[BETOB;

10) natijani jpg formatida saqlaymiz.

@ Nazorat savollari

]

1. Qanday yuvilish filtrlarni bilasiz?

2. Smart Blur filtriga izoh bering. Uning qanday parametrlari mavjud?
3. Gaussian Blur filtriga izoh bering.

4. Lens Blur filtriga izoh bering.
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XII BOB. KOMPOZITSIYALI TASVIRLARNI
YARATISH

Fotomontaj ishlari o°z ichiga quyidagi kabi ishlarni oladi: fonni
o‘zgartirish, ramkaga rasmni qo‘shish, kiyimning rangini o‘zgar-
tirish, rasmdan sanani o‘chirish, sochni tiklash, effektlar qo‘shish,
kollajlar, kompozitsiyali tasvirlar yaratish, jismlar, odamlarning
joyini o‘zgartirish va boshgalar.

Misol ko‘rib chigaylik. Bizning misolda kompozitsiyali tasvir
yaratish uchun uchta obyekt kerak bo‘ladi (133-rasm).

133-rasm. Kompozitsiya uchun tasvirlar (dengiz, flamingolar, oy).
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Yugqorida ko‘rsatilgan uchta tasvirdan kerakli holatlarni kesib
olib, bitta umumiy kompozitsiyali tasvir hosil gilamiz (134-rasm).

Ushbu tasvirdan ko‘rinib turibdiki, dengiz tasviriga turli asbob-
larni go‘llab flamingo va oy tasvirlarini qo‘shdik.

Bunda quyidagi amallar bajarildi:

1) flamingolar tasviridan flamingo kesib olindi va dengiz tasviriga
ikki marta nusxalanib, kerakli joylarga qo‘yildi;

2) xuddi shuningdek, oy tasviridan oy kesib olindi va dengiz
tasvirining yugorisiga joylashtirildi.

134-rasm. Kompozitsiyali tasvirning ko‘rinishi.

m Nazorat savollari

]

1. Fotomontaj ishlari o‘z ichiga ganday ishlarni oladi?
2. O‘zingiz mustaqil ravishda biror kompozitsiyali tasvir yaratish
algoritmini tuzib chiging.
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XTI BOB. TASVIRLARNI CHOP ETISH

13.1. Bosmaga chiqarish oldidan tasvirning o‘lchamini
o‘zgartirish

Tasvirni bosmaga (printerga) chigarishdan oldin tasvirning o‘l-
chamlarini o‘zgartirish uchun quyidagi amallar bajariladi:

1) Image > Image Size (N300paxenne > Pasmep n300pakeHns)
buyrug‘ini tanlang va paydo bo‘lgan muloqot oynasida kerakli
parametrlarni kiriting;

2) agarda tasvirning eni va bo‘yi uzunliklari nisbatini (propor-
siyasini) o‘zgarishsiz qoldirish kerak bo‘lsa, Constrain Proportions
(Coxpanutb nponopimn) maydoniga bayrogchani go‘ying (135-rasm).

— Pixel Dimensions: 628K T [Il
widgth: 100 | percent j] Reset
&

Height:  [100 [percent | ao.. |
i— Document Size:
width:  [430 [ points |
&
Heignt: [27.33 [ picas j]
Resolution: |28,3d6 | pixels/cm

[ Constrain Proportions

¥ Resample Image: |Bicunic vl

135-rasm. Kompozitsiyali tasvirning ko‘rinishi.

Agarda tasvirning enini bo‘yining uzunligiga bog‘liq bo‘lmagan
tarzda o‘zgartirmoqchi bo‘lsangiz, bu bayroqchani olib tashlang;

3) chop etish o‘lchamlarini va tasvirning umumiy piksellari
sonini proporsional ravishda o‘zgartirish uchun Resample Image
(OrtcaexuBath M3MeHeHHs1) maydoniga bayroqcha qo‘ying (135-
rasm) va berilgan interpolatsiya usullaridan birini tanlang: Nearest
Neighbour (Ilo cocennum), Bilinear (bunmneiinbiit) yoki Bicubic
(bukyomueckmit). Bikubik interpolatsiya tasvirning sifatiga kamroq
ta’sir giladi;
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4) muloqot oynasida Document Size (Pa3mep A0OKyMeHTa)
guruhida joylashgan Width (Illupuna) va Height (BbicoTa) may-
donlariga kerakli giymatlarni kiriting. Agarda Resample Image
(Orcaexusatbr u3MmeHenns) maydonida bayrogcha qo‘yilmagan
bo‘lsa, chop etish o‘lchamlari va tasvirning umumiy piksellari
soni proporsional ravishda o‘zgarmaydi;

5) OK tugmasini bosing va natijani oling.

Agarda avvalgi parametrlarini gayta tiklamoqchi bo‘lsangiz,
Image Size (Pazmep m3o0paxenns) Alt tugmasini va bir paytda
Reset (BocctaHoBuTb) tugmasini bosing.

Shuningdek, tasvirning o‘lchamlarini o‘zgartirish uchun File >
Print with Preview (®aiin > Tleuats ¢ ¢ npeaBapuTEILHBIM MPOC-
MoTpom) buyrug‘ining mulogot oynasidan ham foydalansa bo‘ladi.

| File
New... Ctil+N
Open... Ctr+0
Browse... Shift+Ctd+0
Open As... Alt+Ctrl+0
Open Becent »
Close Chil+w/
Save Chl+S
Save As... Shft+Ctrl+S
Save for Web... Al+Shit+Ctil+S
Revert
Place...
Import »
Export 3
‘Workgroup »
Automate »
File Infa...
Page Setup... Shit+Ctrl+P
Print with Preview... Ctil+P
Print... Alt+Crl+P
Print One Copy  Alt+Shft+Ctrl+P
Jump To »
E it Chl+Q

136-rasm. Tasvirni bosmaga chigarishdan oldin ko‘rish
buyrug‘ini tanlash.
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13.2. Tasvirni bosmaga chigarishdan oldin uni ko‘rish

Bosmaga chiqariladigan tasvirning o‘lchamlari u chigariladigan
gog‘oz o‘lchamlari bilan mos kelishini bilish uchun sichqonchani
tasvir ochilgan oynaning pastki gismida joylashgan holat satriga
olib borib bossangiz, tasviringizning qog‘ozda egallaydigan joyini
aks ettiruvchi tasvir paydo bo‘ladi. Yana boshqga usuli: File >
Print with Preview (®aiin > Ileuats ¢ ¢ NpeaBapuTEIbHBIM IPOC-
MoTpom) buyrug‘ini tanlab, ochilgan mulogot oynasidan tasviringiz
gog‘ozda ganday joy olishini ko‘rishingiz mumkin. Agar tasviringiz
bosmaga ganday chiqarilsa, ekranda ham shunday ko‘rinishi kerak
bo‘lsa, View > Print Size (Bun > Pasmep npu neyatn) buyrug‘idan
foydalanish kerak (136-rasm).

13.3. Adobe Photoshop dasturida veb-sahifa dizaynini
yaratish

Bu bandda Adobe Photoshop dasturida varaglararo murojaat-
larni yaratish usullari hagida ma’lumot berilib, ularning imko-
niyatlari ko‘rib chigiladi.

Photoshop dasturi asboblar pane- ¥ Sice Tool K
hdg Slice Tool' asbobi mqVJqd bo‘lib, %4 Siice Select Tool K
uning yordamida tasvirni bir nechta
bo‘laklarga ajratish mumkin. Ajratilgan
gismlarning har biri oz tartib ragamiga ega bo‘ladi. Slice Select
Tool asbobi yordamida bo‘lakni yana bir nechta bo‘laklarga ajra-
tish yoki bir nechta bo‘laklarni o‘zaro qo‘shish mumkin bo‘ladi.
Bo‘laklarning har biri tugma vazifasini bajarib, boshqga bir sahifaga
o‘tish imkonini beradi. Bu turdagi fayllar bilan ishlaganda tasvirning
ruxsat etilgan qobilligi (resolution) 72 dpi bo‘lishiga e’tibor berish
lozim.

Photoshop dasturining o‘zida nafagat veb-sahifa dizaynini, balki
sahifaning o‘zini to‘liq yaratish imkoni ham mavjud.

File menyusining Save for Web buyrug‘i aynan shu vazifani
amalga oshiradi. Ammo aytib o‘tish lozimki, Photoshop dasturi
rastr grafikasi bilan ishlaganligi sababli, fayllarni saglashda har bir
pikselning parametri bevosita hisobga olinadi, bu esa, o‘z navbatida,
yaratilayotgan fayl hajmining ortishiga, keyinchalik esa veb- sahi-
faning sekin ochilishiga sabab bo‘lishi mumkin (137-rasm).
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PASNEWATE ITG HX
" CATTE URG HET... 3

137-rasm. Veb-sahifa dizaynini yaratish.

Veb-sahifa (137-rasm) yaratish uchun quyidagi ishlar algoritmi-
ni bajarish kerak:

1) Mou mokymenTsl papkasida «Veb-sahifa» nomli yangi papka
yaratiladi;

2) varatilgan papkaga bir nechta tasvirli fayllar joylashtiriladi
(masalan, univer.jpg, library jpg, my teacher.jpg, post.jpg);

3) Photoshop dasturi ishga tushiriladi, 600x800 pks o‘lchamda
yangi fayl yaratiladi;

4) amaliy darslarda olingan bilimlarni va dizaynerlik mahoratini
go‘llab, shaxsiy veb-sahifa dizayni yaratiladi;

5) chiroyli tugmalar yaratish uchun Styles (Ctunu) paneli
elementlaridan yoki Blending Options buyrug‘i elementlaridan foy-
dalaniladi;

6) tasvirlarga badiiylik berish uchun Effects (PuasTpsi) menyusi
buyruglarini go‘llash lozim. Rang yorginliklarini o‘rnatish uchun
Image menyusi bo‘limlaridan foydalaniladi;

7) qo‘yilayotgan har bir matn shrifti va tanlangan ranglarning
mavzuga ganchalik mos ekanligiga ahamiyat berish lozim;
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Slice Options b o x|

e D
Name: | post-25095-1176269775_03 Cancel
URL: | Ef@_l
Target: |
Message Text: |
Alt Tag: |
— Dimensions ,
x:[s0 wila7
y: [241 Hi[s2
SlteBﬂgwﬁTme:ml ackarcund Colory [7]

138-rasm. Slice tool asbobi mulogot oynasi.

8) biror tugma orqali boshqga faylga murojaat etishni o‘rnatish
uchun:

Slice tool asbobini tanlab, tugma sohasini ko‘rsatish kerak
(bizning holda 1-tugma);

9) hosil bo‘lgan bo‘lak ustida sichqonchani ikki marta bosib,
ochilgan mulogot oynasida quyidagi parametrlarni o‘rnatish kerak
(138-rasm);

10) Name: 1, URL maydonida post.jpg tugmasi bosilganda
ochilishi kerak bo‘lgan fayl nomi ko‘rsatiladi;

11) File menyusining Save for Web buyrug‘i orqali faylni «Veb-
sahifa» papkasiga saglash kerak;

12) Photoshop dasturidan chiqib, yaratilgan sahifaning ishla-
shini tekshirib ko‘rish kerak;

13) xuddi shu usul bilan boshga tugmalarga ham murojaatlar
o‘rnatish kerak.

Sayt uchun tekstura yaratish

100x100 pik o‘lchamli yangi gatlam yaratamiz, so‘ngra quyi-
dagi amallarni bajaramiz:

1) ikkita rang tanlab, gradiyent asbobini qo‘llaymiz;

2) Filtr > Render > Fibirs buyrug‘ini tanlab, yuqoridagi may-
donga kiramiz;
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139-rasm. Teksturalarga misollar.

3) son‘gra Filtr > Texture > Texturizer buyrug‘i muloqot
oynasida yuqoridagi maydonga kirib, kerakli teksturani tanlaymiz;
4) yaratilgan teksturani jpg formatida saglab qo‘yamiz.

@ Nazorat savollari

1. Tasvirning o‘lchamlarini o‘zgartirish uchun qaysi buyruglardan
foydalaniladi? Ularga izoh bering.

2. Image Size buyrug‘i sozlash parametrlariga izoh bering.

3. Tasvirni printerga chiqarishdan oldin ko‘rish uchun gaysi buyrugdan
foydalaniladi?

4. Veb-sahifa yaratish uchun gaysi asboblardan foydalaniladi? Ularga
izoh bering.
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Glossariy (gisqacha izohli lug‘at)

API (Application Programme Interface) — amaliy dasturlar
ishlab chigish uchun interfeys.

Bitli massiv (bitmap — OGuToBBIi MaccuB) — kompyuter xoti-
rasida yoki diskda saglanadigan rastr.

Dizering (dithering — nuzepunr) — turli ranglardagi bir-biriga
yaqgin joylashgan va nugqtalarni qo‘shib yuborish natijasida hosil
bo‘lgan ranglarning jilolanish illuziyasi.

Dpi (dots per inch) — bir duym uzunlikdagi piksellar soni.
Rastrda ruxsat berilgan gobillikni o‘lchash birligi sifatida qo‘llanadi.

FIF (Fractal Image Format) — fraktal sigish usuli bilan sigilgan
tasvirlar uchun grafik formati.

Foydalanuvchining grafik interfeysi (Graphical User Interfase —
rpacpmiecKuii nHTepeiic momwtb3oBarend) — grafik elementlar to‘p-
lami bo‘lib, u foydalanuvchiga kompyuter tizimlarida gandaydir
operatsiyalarni bajarish uchun xizmat qiladi.

Fraktallar (fractals — ¢pakran) — murakkab formadagi obyekt
bo‘lib, u oddiy iteratsiya sikllari bilan tasniflanadi.

GIF — Internet tarmog‘ida keng foydalaniladigan rastrli grafik
format. CompuServe firmasi tomonidan ishlab chiqilgan.

Grafik qurilmaning interfeysi (Graphic Device Interface —
uHtepdeiic rpadpuueckoro ycrpoiictsa) — Windows operatsion
tizimning osttizimi (tizimchasi).

JPEG (Joint Photographic Experts Group) — rastrli tasvirni
samarali sigish usuli ishlatiladigan grafik format.

Kompyuter grafikasi (Computer graphics — kKoMmmnbloTepHas
rpapmka) — kompyuter yordami bilan tasvirni hosil gilish.

LAW — axborotni siqish usuli bo‘lib, undan GIF formatli
fayllarda foydalaniladi.

Liniatura — bir birlik uzunlikdagi nugtalar soni. Dizering usuli
bilan rastrlashni tasvirlash uchun foydalaniladi.

MIP mapping — teksturali sirtlarni chigarish sifatini oshirishni
ta’minlash magsadida turli rakurslar, ko‘rsatish masshtablari uchun
bir nechta tekstura variantlarini saglash.

Oyna (window — okHo) — grafik obyekt chiqariladigan soha.

Palitra (palette — manuTpa) — ma’lum bir tasvir uchun muhim
bo‘lgan ranglar to‘plami.
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PDF (Portable Document Format) — elektron hujjat fayllari-
ning formati.

Piksel (pixel — nmukcenn) — rastr elementi.

Plotter (plotter — rutoTTep) — tasvirni qog‘ozga aks ettirish
uchun mo‘ljallangan vektor tasvirlar bilan ishlovchi qurilma.

Rastrlash (rasterization — pactepusamus) — tasvir elementlari-
ning vektor (yoki boshqga) tasnifi asosida rastrli tasvirni hosil qilish.

Rastrda ruxsat berilgan qobillik (resolution — paspetnarorias
cnocoOHOCTh pacTpa) — rastrlar va rastrli qurilmalarning xarak-
teristikasi. Bir birlik, masalan, bir duym, uzunlikdagi piksellar
soni bilan o‘lchanadi.

Rastrli grafika (raster graphics — pactpHad rpaduka) — o‘zaro
yaqin joylashgan turli rangdagi nuqtalar (piksellar) to‘plami asosida
tasvirni hosil qilish.

Rastrli shrift (raster font — pacrposbiii mpugT) — simvollarning
rastrli tasvirlar to‘plami.

Rendering (rendering — penaepunr) — axborotni grafik ko‘-
rinishda aks ettirish jarayoni.

RGB (Red, Green, Blue) — rangning additiv modeli.

Skaner (scanner — ckaHep) — grafik tasvirlarni kompyuterga
kiritish uchun mo‘ljallangan qurilma.

Sprayt (sprite — copaiiT) — rasmning ma’lum bir obyektining
rastrli tasviri bo‘lib, u bitlar massivida saqlanadi va nusxasi zarur
joyga tezda ko‘chiriladi.

Teksel (texel (texture element)— Tekcenn) — rastrli tekstura
sirtida relyeflilik illuziyasini hosil giladi.

Tekstura (texture — tekctpya) — bo‘yash stili bo‘lib, obyekt
sirtida relyeflilik illuziyasini hosil giladi.

Teksturani filtrlash (punsTpaims Tekctyp) — obyektlar sirtiga
tekstura qo‘yishda tasvirni interpolatsiyalash, o‘zgartirish usuli.

VMR — Windows operatsion tizimidagi dasturlarda keng
foydalaniladigan rastrli grafik format. Tasvir bit shaklidagi massiv-
larda saglanadi.

XYZ — Yoritish bo‘yicha Xalgaro komissiya tomonidan gabul
gilingan rang modelining nomi.

Shrift (font — mwpudt) — kompyuter tizimlarida matnni tas-
virlash uchun simvollar to‘plami bo‘lib, ular bir xil stilga, o‘l-
chamga, akslantirish usuliga ega.

CMY (Cyan, Magenta, Yellow) — subtraktiv rang modeli.
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